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Welcome

WELCOME

Hi, Welcome to Embrilliance Essentials!

Thanks for reading this User Guide! Since you're here, let us tell you some things about this exciting
program because Essentials represents a giant step forward in embroidery.

For starters, it is a small, yet feature packed program that is easy to install. It has versions for both
Mac OSX and Windows. Windows versions install on XP, Vista and Windows 7/8 (including a separate
Win 7/8 64-bit version.) It requires no hardware dongle and can be installed on multiple systems requir-
ing only your personal serial number to be typed in for the program to run. Once you enter a serial num-
ber, you can register the program, which provides several benefits. One of those benefits is that if you ev-
er lose your serial number, we can recover it for you.

This manual covers the features in the program Embrilliance Essentials and its available feature
packs. The idea behind Essentials is to include the features, which are essential for every embroiderer,
yet not to overwhelm the user with unnecessary extras. It is designed to be simple and easy, yet powerful
enough to accommodate the person who wants to do more than simply using existing designs. The fea-
ture packs are additional programs that you may purchase to add on to your Embrilliance Essentials to
make it YOUR software. No need to learn a new program! You simply add new features and functions as
you want them to your existing software.

The Essential Features

* 12 Fonts for multi-line text, monogramming and circle text.

» Sample designs, which are scalable and recalculate their stitches as you interactively transform
them.

* Unlimited lines of letters or monograms and embroidery designs can be combined.

* You can mix and match fonts and sizes.

» Merge existing embroidery files into your design.

* Browse and Merge designs in folders and from inside .ZIP files.

» Resize existing embroidery files with stitch recalculation. You can resize embroidery designs up to
250% and down to 50%.

* Colorize any embroidery design. You can change the colors one at a time, or convert the entire de-
sign or any selected part of it to your preferred thread brand with just a few mouse clicks.

» Simulate the sewing of any design. The simulator can play in 3D, play forward and backward, and
has variable speed. The simulator also has a slider so that you can manually scroll forward and
backward through the design to any point without waiting. You can even insert a color stop in the
sewing process.

» Convert any design from one format to any of the supported types, which include:

» Read: ART, CND, CSD, DST, DSZ, EMD, EXP, EXP+, GNC, HUS, JAN, JEF, JEF+, PCM, PCS, PEC, PES,
PHC, SEW, SHV, TAP, VIP, VP3, XXX, EMB.

» Write: CSD, DST, DSZ, EXP, EXP+, HUS, JEF, PCS, PES (v1-9), PCM, SEW, SHV, TAP, VIP, VP3, XXX.

» Designer 1 Disk Utility for floppy and USB machines.

* Split designs for several multi-position hoops, including the Brother/Baby Lock 100x100 machines, and the
14” x 14” Jumbo Hoop.

* Project Advisor, a patented expert system with guidance to help successful embroidery on all your projects.

» Create a working file (.BE extension) to save your design as an editable and merge-able file. Your
working file is saved for you automatically when you save a stitch file so you don’t have to ‘Save’
twice every time you make some changes—once for the stitch file and once for the working file.

* Embrilliance has an advanced program interface that’s super easy to use yet offers features nor-
mally reserved for very expensive programs.
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* Real Scale zooming allows you to view your designs on screen at the actual size that they will stitch
out.

* Navigation Window that provides instant control over the zoom and scroll in the program’s view.

» Sewing Order control allows you to re-sequence the designs to sew in the order you want them to
sew.

» Color Sorting control to intelligently reduce the number of extra color changes.

» Some fixed-point multi-position hoops are included. Essentials will automatically split your design
layout upon the Save.

 Adjustable Mouse Wheel attribute for Zoom or Scroll.

» Simple centering in the hoop plus advanced alignment.

» Thread Palette creation and thread inventory system.

» Basting designs.

» Automatically check for updates.

 Digital Rights Management (DRM) so that you can preview embroidery designs before you pur-
chase them!

ADDITIONAL ACCESSORIES

AlphaTricks

e AlphaTricks works with alphabet design packs sold by any digitizer / design company. Alphabet
designs are easily mapped into the font list, turning the letters into a keyboard font with the pa-
tent-pending automatic kerning feature.

Density Repair Kit

e Density Map and Wireline views (Our patented feature) which helps identify overly dense designs before

they are sewn.

e The Sweep Tool which automatically reduces stitch count, time and puckering. Dramatically improves the
suppleness of a sewn garment. Removes clumps of stitching which prevent free travel of the hoop. All auto-
matic.

o The Project Setting which takes advice from the expert system in the Project Advisor and uses it to apply
settings to The Sweep.

Enthusiast

o Stitch Editing, including Split, Insert and Delete, Pull compensate and adjust stitch.
e Multi-Position Hoops.
e Basting stitches added to allow perfect alignment
o Split to Hoop function allows you to preview your split design before you go to the machine
¢ Creates a working text file to match the original color order with the split sections
e Advanced splitting technology reduces the visual “seaming” that can occur when a design is manually split
using an editing program.
e Asstand-alone program:
e Merge existing embroidery files into your design.
e Resizing is limited to 17% for merged designs
e Includes 1 block font
e Sew Simulator with stop
e Change colors
e Precision tools for design placement.
e Repeat, Scatter, Carousel, & Mirror x4 designs for tiling, custom frames and artistic implementations



Installation

More About the Fonts

These fonts give you enormous control over them. The specifics vary depending on which lettering
style you're using, but in general, you can adjust the font, color, size, aspect, center, rotation, mirroring,
slant, kerning, layout, stagger, sequence, envelope shape, stitching properties including density, underlay,
underlay density and compensation (which can be used to increase boldness) for the design as a whole.
And you can adjust the color, size, position, rotation, kerning, aspect and mirroring down to the individu-
al letter. You can adjust the letter sequence for Monograms so that letters may overlap exactly how you
want them. And if you do overlap your letters within a Monogram, the hidden stitches are automatically
removed for you so that the design sews out nice and flat. For fast and easy Monogram setup, you have 14
Quick Styles to layout your design, including Vertical, Square, Oval and Diamond.

When sizing letters, your letters automatically switch to a fill-like satin stitch. This looks like a fill, but
unlike a fill, the stitches maintain the beauty of the curved satin column. Another benefit of this is that
fonts can be made far larger than ordinary embroidery fonts - some as tall as 8”.

To make the fonts even more versatile in size, automatic adjustments are made for you to help the let-
ters sew smaller than they would in other programs. For instance, when you make the letters smaller,
narrow satin stitching is automatically adjusted to keep long-enough stitches to actually sew. And alt-
hough some small designs look good on screen, they won’t embroider well. The fonts in the program pro-
tect your stitching automatically.

Multi-Line text offers line spacing, and in Circle Text, you can keep on typing, right into a spiral!

And Embrilliance can further be extended by adding font and design packs, now available from your
dealer or online at http://www.Embrilliance.com.

Welcome to Embrilliance, and let the fun begin!

INSTALLATION

Installation of Embrilliance is easy. First install the disc or download the installer. If you have the disc,
XP may automatically run it, but in later versions of Windows, Auto-Run has been turned off by Microsoft,
so you'll have to browse to it using Windows File Explorer (a.k.a. “Computer” or “My Computer”). Look
for the program with “Setup” in the name and double click on it. This will start the installation. In Win-
dows it looks like this:
15! Setup - Embrilliance = | S WSS 8l setup - Embrilliance SRR T

T License Agreement
Welcome. to the Embrilliance Please read the following important information before continuing. m
Setup Wizard (&

This will install BriTon Leap Embriliance 1.06 on your computer. Please read the following License Agreement. rou must accept the terms of thiz
agreement before continuing with the installation.

Itis recommended that you close all other applications before
continuing. END-USER LICEMSE AGREEMENT For BriTon Leap Products -

Click Next to continue, or Cancel to exit Setup. All software and designs are Copyright, BriTon Leap, inc,

Embraidered goods created with the designs included in this praduct may be rezold
in limited quantities without permiszion. |f more than 500 designs, in any combination
from this design collection. are embroidered on or as goods for resale. you must
obtain permission from Tacony and BriTon Leap, inc.

The BriTon Leap software [''Software’] is protected by copyright,
The Software is licensed, not sold T

@ | accept the agreement

) | do not accept the agreement

| Next > |{ Cancel ‘ l < Back H MNewt > J{ Cancsl |

Click ‘Next,’ then accept the license agreement by clicking the button, then click ‘Next,’


http://www.embrilliance.com/
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i5! Setup - Embrilliance =] e B 5! Setup - Embrilliance

Select Start Menu Folder
‘Where should Setup place the program's shartouts?

Select Destination Location
‘where should Embriliance be installed?

Setup will install Embriliance into the following folder. | Setup will create the program's shortcuts in the following Start Menu folder.

Ta continue, click Mest. IF you would like to select a different folder, click Browse. To caontinue, click Mext. |f you would like to select a different folder, click Browse.

‘ Browise... [E mbrilizncetE mbiliance] ‘ Erawse...

At least 2.5 ME of free disk space is required. or't create a Start Menu folder

{ < Back ” Hext > J{ Cancel | I < Back ” Mext > JI Cancel |

Click ‘Next.” You will usually want a desktop icon for ease of running the program. Click ‘Next,’

18! Setup - Embrilliance Lo 0[RS B) Setup - Embrilliance L=

Select Additional Tasks
Which additional tazks should be perfarmed?

Completing the Embrilliance Setup
Wizard

Setup has finished installing Embrilliance on your computer. The
application may be launched by selecting the installed icons.

Select the additional tasks you would like Setup to perform while installing Embrilliance.
then click Next
Additional icons: Click Finish to exit Setup.

| Create & deskiop icon | Launch Embriliance

< Back H ext » JI Cancel Finish ‘

You are now ready to begin installing. Click ‘Install,’
i5) Setup - Embrilliance =] J

Completing the Embrilliance Setup
@ Wizard

Setup has finished installing Embriliance on your computer. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.

V| Launch Embiliance

[Frsh_]

You can run Embrilliance now, or you can just quit the setup by unchecking the Launch box.

You are finished installing!



OVERVIEW

Overview

Below is a picture of the Embrilliance window:

5 Embrilliance - Untitled 1 *
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As with most programs at the top of the window is the Main Menu, and below the Main Menu is the
Main Toolbar. These two components are always available and handle the most significant com-
mands of the program.

The Tool Pane is a little different. It will display different contents, depending on what type of task
you are performing. For instance, if you are running the Sewing Simulator, the controls for the sim-
ulator will appear in the Tool Pane.

The Main view displays the current Design Page. A Design Page is a representation of a .BE file,
which can contain multiple embroidery designs, lettering objects and frames.

More than one Design Page can be open, and these are selectable by using the tabs above the Main
View, just below the Tool Pane. As you save Design Pages, they will take the names you have given
them. Until a page is saved, it will be called “Untitled...”

The Status Bar provides relevant information about what is going on with the program’s current
operation. For instance, if you are measuring items, the text in the bottom right corner of the Status
Bar will update with the measurements created by that tool.

The Navigation view provides an easy-to-use way to navigate around the current design page, and
to control the zoom for it. This is especially useful when you have a lot of objects on a large design
page and you want to go from one place to another without repeatedly zooming and scrolling.

The Objects view displays Designs and Objects sequential order as they are opened or merged onto
the design page. Each root (leftmost) item in the Objects view is a Design. A Design or object may
be, for example, a lettering design, or perhaps a regular embroidery design.

The Designs in the Objects view can have objects within them. To view those objects, click the ‘+
which opens up the tree, thereby ‘disclosing’ the objects in the design. With a normal embroidery

Zoom: 168% Cursor: 1,6mm x 38,5mm Stikches:3403 _ Ndis/Cols: 11
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design merged into the page, you will be able to see individual colors within the design once you
click the ‘+.” Some designs, like lettering designs, may not disclose their individual objects because
all editing is done via the Properties view.

» The Objects view can also be used to select designs and objects, which is useful when objects within
a design are grouped, such as with regularly merged embroidery designs.

» The Properties view displays information and controls for the currently selected objects and de-
signs. For example, if a single-color design such as lettering is selected, you will see in the ‘Color’
property page only the single color for the lettering. If no design or object is selected, the Color
property page is shown and the colors for the entire design page are shown.

The Essentials Library Window
The Library window is used to merge designs into the current Design Page.

Selection

L W g
Frame 1 Frame 2

Frame 3 Frame 4

N &

The Interactive/Moddie Selection Window is used to merge Embrilliance designs into the current De-
sign Page.

Clicking on a collection icon on the right will result in the designs from that collection to appear on the
left. To import a design, select it and click OK. You can also double-click on a design to import it and close
the window.

Cancel

Note: In most cases, the merged library design will be placed on the screen to fit the hoop, whether
the hoop is displayed or not. If you have a very small hoop selected, the library design may be too com-
plex to be shrunk to fit the hoop. Library designs can be resized to the desired proportions after place-
ment.

Note 2: Whenever you add any design—whether Library, Lettering, or any design file—it will be ini-
tially placed in the center of the hoop. If for some reason you don’t see a newly added design, zoom out so
that you can see the center of the hoop.
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The Stitch Files Window

The Merge Files Window is used to merge existing embroidery files into the current Design Page.

r M
#  Open Design Files lﬁ
e ED o
O T &

Size 3D Close  Import

Browse | 2
int10 - =
ISS
=] John Deer
o] AG stuff
AY stuff

o} installer sample for brian = ADORLART ADORZ.ART ADOR3.ART
@4 Lace -
new products cover mockups

[ Sewing & Stitchery Expo

W iristaller CO files zip

i installer sample for brianzip

i Installer VISE 3.6.1zip

! John's Vermicellizip

! McloyfullszFestivalpha.zip

Lananane Menn demn X ADOR4.ART ADORLPES ADOR2.PES
i

» -

C\John Deer\installer CD files.zip » »installer CD files/Files To ADD to CD/extras/bonus_designs/artista-art/ADOR3.ART
€

The Browse view on the left side is called a ‘Tree’ control, and it has a ‘Root’ level, which is left-most
and ‘branches’ which you can open and close using the ‘+’ and ‘-’. You will also see individual .ZIP files as
branches, so you can import designs directly from within those as well.

On the toolbar, there are controls for thumbnail size and 3D display. The ‘Close’ button will close the
window without importing anything. The ‘Sel. All’ button selects all the designs in the view on the right.

To bring designs in, click ‘Import’.

As with most views like it in Windows, the thumbnail view on the right allows single design selection,
by clicking on an item. But also you can select a range of designs by first selecting a design then holding
the shift key down and clicking another design. Additionally, you can use the control key to click on dif-
ferent designs that are not next to each other, and that will select those too. This is called a disjointed se-
lection.

You can also double-click on a design to import it and close the window.

Embrilliance Design Pages

A Design Page is where designs and lettering can come together to form a composition or a scene.
That page is also represented as a single embroidery (or working) file. For example, you may have
merged multiple embroidery designs, added a couple lettering designs, and then surrounded them with a
Library frame. All those individual designs exist on the Design Page. That scene can be saved as an em-
broidery file for use in your machine, and it can also be saved as a ‘Working File’ (extension .BE), which
allows for editing later. (Suppose you miss-typed some lettering.)

As Design Pages are opened or saved, their name will appear in the Tabs above the Main View. You
can switch between Design Pages using the Tab View. This is handy for clipboard operations such as do-
ing a copy and paste between Design Pages.

4 Untitled 1 * Untitled 2 3

| | | | I | | | | | | |
H‘” ]-1llclrn13 I-12 I-H I-10 I-S I-8 I-? I-S I-S I-'l
©
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Designs

Each Design on a Design Page is one of the three types, ‘(Embroidery Design,” ‘Lettering Design’ and
‘Library Design.’ These design types work together to build useful embroidery compositions. The designs
are visible on the Design Page in the Main View, and the sequence of the designs is visible in the Objects
View.

Designs are collections of objects. For example, a merged embroidery design is a collection of color
objects, each of which contains stitches for a single color in the design.

Designs may be ‘Grouped’ which allows you, the user, to select and move the design around in the
Main View as a single design. By default, when you merge an embroidery design into the page, it comes in
as grouped. If you want to change one or more colors (or objects) in the design, you have some options:

* Ungroup the design, which makes each object selectable in the Main View.

» Select the object or objects in the Objects View.

Designs as they appear in the Main View may be ‘Locked’ which prevents inadvertent moving or edit-
ing. The lock may also be used to hide the design(s). The state of the Lock is set using the Objects View
toolbar.

Embrilliance Objects

Each Design on the design page can contain one or more objects, each of which contains colors, stitch-
es and other information. The only objects you will see are individual color objects within a merged em-
broidery design. Each object can be moved, edited, deleted, etc.

The Windows Docking Pane Interface

This interface can be configured and the configuration is persistent, i.e. it is remembered between
program invocations. The controls for this interface consist of a Pin, a Close Box and a Tab. The Pin and
Tab are related. When the Pin is “unpinned” the window slides into the main window frame and presents
a Tab with the window name. When the Pin is “pinned” the window stays open and the Tab goes away.

In the unpinned configuration, hovering the cursor over the Tab reveals the window. When the cursor
is moved out of the window it slides back into its unpinned position.

The Close Box dismisses the window altogether. To restore a dismissed window you must use the
View Menu->Toolbars and Windows item to restore the dismissed window.

B e 9

Left: Unpinned Right: Pinned
l:l
2 1B Embriliance - Untitied 1+ g i i
~
| File Edit |Wiew | Foom ‘Window Help
b Toolbars and Windows.., » Reset Windows and Toaolbars
N A h‘ 3
+ v Metric v Mavigator Window
(a5} = v Draw stitches in 3D ¥ Main Taalbar |
;-:— v Draw Grid v Wiew Toalbar
(D
S v DrawHoop v Design Toolbar T
Stitch Simulator | OB T B
I Stitch Points v Properties Window
= Abhout this page.., ¥ )| Statuis Bar
- D st et S s e B
Left: Pinned Windows. Right: Reset Windows command in Menu.



Files

Embrilliance uses a few different file types, each having its own file extension. For example “BE’ is a
working file. This file type contains all the Designs and Objects representing a single Design Page. These
designs and objects can be edited, as they have not been forced to become a simple set of stitches, which
is what most machine-embroiderable files are.

Licensed files, such as fonts will have .BF and .LF files. These are installed by the installer for our col-
lections. You cannot edit or use these files as a user. The program loads them automatically as needed.

Stitch files, which in the commercial embroidery trade are called ‘expanded’ files such as .PES or .DST
are simply collections of stitches, and if you are lucky, colors.

Saving

When you save a Design Page it will ask you to choose which Stitch File type you want to use. For ex-
ample a Baby Lock / Brother embroidery machine owner will choose .PES as the stitch file type. In addi-
tion, the program will also silently save a working file (.BE) thus saving you the extra step of saving it
separately. As mentioned earlier, the working file allows you to edit your designs including text. If you
want to save individual files (not both stitch and working) you have all the options on the File menu.

Open vs. Merge

Files can be ‘opened’ which starts a new Design Page in the Main View so that you can see the open
file. Use Open for .BE files.

If you already have a Design Page open, you can ‘merge’ files, which adds the contents of the files to
whatever you have on your page currently. To merge a file click on the Merge icon on the Toolbar or go to
File/Merge Stitch file or Merge Working file



Embrilliance

THE MAIN VIEW

Design pages are displayed in the Main View of the program. There can be multiple design pages open
at any given time. For each page in use, a Tab control is displayed at the top of the Design page. Additional
Design pages are added by clicking the New button on the Main tool bar, by pressing Ctrl-N by choosing
New Page from the File menu or choosing New from the Window menu:

B Embrilliance - Untitled 1

FIEW Edit  Utility  View Zoom Window Hel

Mew Page Cerl+M

Lo Open... Ctrl+0
Close

A design page is activated by clicking its Tab control. Or you can select it from the list in the Window
menu.

Embrilliance - U
:| File Edit Digitizer View Zoom ‘Window Help
o | New :
—a L
G| "'l_ 1Untitled 1
< @inch | ¥ l— 2 Untitled 2*
i v 3 Untitled 3

.[ 4 Untitled 1 *

I%III'?‘:‘II;I‘IllI!'Z'I'I‘

The Tab control will display the name of the file associated with the page once it has been saved, oth-
erwise it is named “untitled x” where x is a running number.

The Main View has a background, a hoop, and rulers along the side and, naturally, the designs you
have placed in the Design Page.

Welcome
to
Embrilliance

10



The Main View

Zooming

m Window  F Zooming is handy for edits, and this makes the process of zooming more conven-
ient. Also, one of the options in the program is to be able to use a mouse wheel to

Heop 0 scroll the design page up and down. If you have this mode on, the zoom slider is an-
Al A other useful tool. Just a reminder, there are also keyboard shortcuts for zooming: ‘z’
Selected S zooms in, and ‘Z’ (shift-z) zooms out.

1:1 1

301 3 Zooming can also be accomplished with the Zoom Menu and Toolbar con-
61 6 trols.

» ‘All’ zooms to all objects on the design page.
» ‘Selected’ zooms to selected objects on the page.
* From the Zoom menu specify what should be zoomed: the Hoop, All elements or the Selected ele-
ment or choose the amount of zoom.
Tip: Memorize the keyboard shortcuts for the Zooming and Panning; using them can speed your de-
signing!

& Use the Zoom slider to zoom on the Main view. Up zooms in, down zooms out.
There are zooming keyboard shortcuts:

e ‘Z’tozoom in

e ‘7’ to zoom out.

* 0 =FitHoop

* ‘A’to zoom all

* ‘S’to zoom selected

* 1-9 will zoom to 100%-900% of real-world scale.

7N
./

Magnify

. The Magnifier on the Main toolbar will let you change the zoom in three ways after you click on
it:

» Left-click to zoom in
 Right-click to zoom out
* Drag arectangle to zoom on just that area. (This will also cancel the tool.)

Note: The Overview or Navigation window can alter the zoom too, and we’ll cover that in its own
chapter.

Measure Size and Counts (Stitches and Colors)

% The Measure button on the Main toolbar will set the program in a mode, which allows you
to measure items in the Main View.

11
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As you drag the cursor, you are measuring the distance you've dragged. This distance is displayed on
the status bar:

13.8mm x 0.2mm, len: 13.8mm, -179°

To cancel measuring, click again on the Measure button in the toolbar, or click the Selection Tool (ar-
row) in the toolbar. Items that are selected also have their size, stitch count and color count shown in the
status bar. If nothing is selected, then the size and counts for the entire Design Page will be shown.

71.5mm x 24.2mm Stitches:2232 Ndls/Cols: 1/1

Viewing in 3D

easily see where the needles will penetrate the fabric. This can be turned off using the ‘3D’ but-

The default setting for the Main View is to display stitches in a realistic 3D, which lets you
|_ ton on the main toolbar.

Background and Grid

= You can alter the background of the Main View. Click the Preferences button on the Main toolbar.
This will bring up the Program Preferences window, which allows you to set many program and
Design Page options. Click on the Grid Settings to adjust them.

Program Preferences

Enviranment ~Show Grid as: —— ~Metric Spacing {(mm): —~Inch Spacing: —————————
Hoops
P @ Lines Horizontal: IlU— Horizontal: |1
; = <<
Callbrate scicen " Dots Vertical: |10 Vertical: |1
Mouse Wheel
Check for Updates - : [_ - :
Ghost Mode Snap To Grid Reset to Defaults
Digitizing LI
(] Conversion
(] Files
(2 Printing
(3 Adjustments
OK I Cancel l Apply |
To change the background color, click the Color button, which will display a standard color picker:

[2]X]

Basic colors:

(et fmf § 0
HMTETENN
ERNNEEEEN
ENEEEEEN
AN EEEEEN
4§ R 0 ok I

Custom colors:

PR T e
Sat:% Green:ﬁ

: | ColotlSold |y [221  Blue: 215

oK | Cancel | Add to Custom Colors |

You can even create your own colors and add them to the custom colors section.
Select a Custom color and click OK to set the new color.

12



The Main View

Adjustments:

The Grid is adjustable too. You can alter the display of gridlines by choosing between lines and
dots. You can also set the spacing of the grid, and that can be set separately for both metric and inch
settings.

The arrow buttons, labeled “>>" and “<<,” will copy the settings from inches to metric and vice ver-
sa. Thus, you can set up a grid that has metric spacing for machine/hoop accuracy, but can display
information to you in inches.

Snap-to-Grid will help align objects to the grids as you move them in the Main View. As you move in
one direction (up, down, left, right) the edge of whatever you are moving will ‘stick’ like a magnet
to the grid as you approach a grid line in that direction. If you want to overcome the snap-to-grid,
you can pass the grid and then come back in the reverse direction. (Which means the opposite edge
will want to snap to some other grid.)

Grids do not force you to stick to them when Snap-to-Grid is on. Rather, it merely enables the snap
as you get close, which may help with precision alignment as you move things around.

Using the menu or the Grid button on the toolbar, you can turn the Main View display of the grid on
and off.

Display Calibration

The Main View is calibrated to a real-world scale for precise display of designs. Use the Preferences Win-
dow to calibrate your display for real-world size:

Program Preferences @

[<3 Environment Move the slider until the line is 2 inches long, or 5 cm if you have
Hoops the "Metric' box checked.
Grid Settings

» W metric |

Mouse Wheel
Check for Updates
Ghost Mode

(L1 Conversion

(] Files

(] Printing

(1 Adjustments

OK | Cancel | |

Hold a ruler up to your screen and adjust the slider until the measurement in the program matches
your real-world ruler. This will help you better estimate real design size while editing designs.

The Mouse Wheel

The Mouse Wheel can zoom the Main View in and out. It can also be used to scroll the page up and
down. We recommend that you use the setting that allows for zooming as this is more useful to most us-

€ers.

=i HMouse Wheel
Grid Settings " Adjusts Zoom
Calibrate Screen  Serolls Window
N
Check for Updates
Ghost Mode
(L3 Conversion
(2] Files
(L Printing
(23 Adjustments
OK I Cancel

13
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Ghost Mode

Ghost Mode is an option relating to how the Main View displays objects when not selected. The idea
for Ghost Mode is to make it more obvious which objects are selected by fading out those items that are
not selected.

Left: Ghost Mode on. Right: Ghost Mode oﬁ‘.

Program Preferences

Environment
Hoops Ghost Mode intensity: 10% —Ji
Grid Settings
Calibrate Screen
Mouse Wheel
Check for Updates

»

(L] Conversion %

(] Adjustments

The intensity of the Ghost Mode can be altered with the Preferences.

Panning and Scrolling

e L ’q LT S R The scroll bars at the right and bottom of the Main View can be used to
' scroll the view around, which is very useful when you are zoomed in.
Werrreverdiirerl There is also a mode that allows you to ‘Pan’ the design, which works like

a scroll, but where you move the view by dragging the mouse. Hold the space
Q".? bar down and drag the mouse to pan the view.

*

Auto-Scroll
As you drag on the main view, you may come near the edge of the page. This will cause the page to
scroll thus enabling you to drag into a position that’s not currently in view.

Rules and Rulers

Rulers exist along the top and left sides of the main view.
I'In.!1 L I

'
_'____.I__l ______ Fe===q======== r___.l__ *
1 1 d | 1 1 1
R e e e I R ¥ S
e 1 f f

B R e e e e L T I [ TS,
1 1 | 1 1 1 1 1 1 1

— | ' '

' ' '

- (N W TUNDE RERIDEU MRSUEDEN TR DU (! TR Lo
1 1 1 1 1 1 1 1 1

! | ' '

= i ' '

1= 1 1 1 1 1 1 1 1

e it B il il B B e e B B e r---
' ' '

- 1 ' g

e 1 1 1 1 1 1 1

They 1nd1cate location from the center of the hoop. You can switch the rulers between metric and
inches using the radio buttons on the Tool pane or by double-clicking in the size window in the status bar.
14



The Main View

You can also drag rules onto the Main view. Move the mouse over one of the rulers and drag down in-
to the view. If you later want to move the rules, you can drag them. If you want to remove them, you can
drag them one at a time back onto the ruler.

Selection

‘3{:} One of the most common tasks in the Main view is to select items. Using the Selection Tool
(Arrow button on the main toolbar) you can select and move items in the design page. Select
items by clicking on them. This will place ‘handles’ and a dotted line around the selected items.

{ | , . . .
You can also see that items are selected by looking in the Objects view. Another way to select items in

the Main view is to drag a rectangle around those items. Anything completely in the rectangle will be se-

lected. However, if an object is grouped with something outside the rectangle, it will not be selected.

Status Bar

71.5mm x 24.2mm Stitches:2232 Ndls/Cols: 1/1

The status bar is located at the bottom of the program window. Size, stitch count and color count in-
formation appear on the right side of the status bar. If you have no design selected, then the display will
contain information about the entire design page. If you have something selected, then the information
contains the word, ‘Selected’ and represents only those selected items.

You can double-click on the size information in the status bar to quickly switch between metric and
inches on the design page and status bar.

The status bar also has a line of text on the left that can provide additional information about an on-
screen control. Hover the mouse over a control, specifically a toolbar button, and the status bar may pro-
vide additional clarification of what the button does.

15
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NAVIGATION

The Navigation H.U.D. (Heads Up Display) is an ingenious device that keeps navigation tools
readily available, yet tucked away, for easy access to the entire working area on your Design
Page. To access the Navigation H.U.D. (aka: Nav H.U.D.), click the Compass Rose icon at the top of
the zoom slider in the upper right hand area of the main view.

The Nav H.U.D. is especially useful when working on large designs and/or a small monitor. It quickly
gives you a bird’s eye view of your work area as well as a nice “you are here” indicator. In the following
image, the area around his eyes will be centered on the screen.

As you move the cursor, the ‘+’ indicates the area of focus. The panel lets you pan around the design
page. The benefit is that you can make edits to different design sections while you are still zoomed in to a
comfortable level.

al[sl[H > E

The Nav H.U.D works in conjunction with the Pan Tool, which is accessible by holding down the
spacebar.

¥

Hold the spacebar and drag with this cursor to pan.

Whereas the Pan Tool is useful for moving around the area you are currently working in, the Nav
H.U.D. makes it easy to scroll across the entire page to a specific place in one easy step.

The chosen hoop is shown in the Nav H.U.D. whether that hoop is visible or not. This is because the
size of your workspace is related to the size of that hoop. The selected hoop is a visual reference only and
does not prevent you from designing or saving projects larger than the selected hoop or, for that matter,
larger than your machine can sew.

Therefore if you have a small hoop selected and a design that well exceeds the hoop boundaries, it is
possible that you won’t be able to navigate to the outer reaches of your design. The solution is to select a
larger hoop from the Environment > Hoops option in the Program Preferences panel.

16



Hoops

AllS H R x |2

[ e

Same design with the hoop set to 60mm x 40mm with the cursor shown
at the upper left limit. Parts of this design are inaccessible.

Normally, once you've panned or zoomed in the Nav H.U.D. the panel will automatically close when
you release the mouse. If you'd like to leave the Nav H.U.D. open while you move to several locations, click
the ‘Pin’ button just to the left of the close box. Once pinned, the panel will stay open until you click out of
it, or click the ‘Close’ button on the top, right in the H.U.D.

1 m A (& m A
g}:; g}:;
Unpinned (default setting) Pinned

Notice on the top of the Nav H.U.D. are three small buttons labeled ‘A, ‘S,” and ‘H.” These buttons cor-
respond to preset zoom settings of ‘All,’ ‘Selected,’ and ‘Hoop,” whose keyboard shortcuts are respectively
‘A ‘S, and ‘0.

Just below the compass rose icon is a zoom slider. Slide up to zoom in; down to zoom out. Click on the
‘+’ and ‘-’ buttons to zoom in and out also. If you've ever used an online map, this zoom slider control
should feel familiar. The slider control also responds to numeric key entry. For example, pressing 5 will
move the slider control to 500%.

HOOPS

The hoop that you will view in the Main View is chosen for the Design Page using the Preferences
Window also.

Program Preferences @

1=y Environment
% Hoops PES T <] [Heopst:
: P i e
Grid Settings T Normal ¢ Multi-Position
Calibrate Screen ety
Mouse Wheel 300mm x 200mm New
Check for Updates 300mm x 100mm
Ghost Mode 200mm x 300mm Edit
TR 200mm x 200mm (Elisimo/Quattr: e
Digitizing

@ 180mm x 300mm
Conversion
(2 Files

(23 Printing
2 Adjustments

Delete

I Rotate 90

o Defaults

Sewing Field:
Width: 100 mm.
Height: 100 mm.

o | coee
Left: Hoop selection. Right: What a hoop looks like in the Main View.

17
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Using this window you can select different hoops, the selected hoop to be shown rotated 90°, add new
hoops of your own creation or edit the selected hoop. The ‘Defaults’ button reloads the hoops that are in-
stalled with the program. This is useful if you update the program or have previously deleted some de-

fault hoops.

Note that when you create a new hoop or modify an existing hoop, that you are really defining the
sewing area, (or what is known as the sewing field), not the physical dimensions of the hoop. You must
know your machine’s embroidery field as you cannot create a hoop that is larger than what your embroi-

dery machine can sew.
Note: When you create a new hoop, it will become the selected hoop.

Trouble shooting: “I can’t see the hoop and it’s checked in View > Draw Hoop.”

There are 3 primary reasons this can occur:
e Avery large hoop may be outside the visible work area
» A very small hoop may be completely covered by the design.
e Designs are outside the range of the hoop and your view is zoomed in, causing the hoop to be

outside the currently visible area

Check the status bar at the bottom of the window for hoop information, which displays the selected
hoop whether it is visible or not. Zoom out to find the hoop (if it isn’t buried under your design).

Splitting for Multi-position Hoops
Manufacturer multi-position hoops are listed with “Multi” after the hoop name. These hoops allow
you to hoop fabric and stitch out a design that is larger than your default sewing area. The hoop is com-
prised of 2 or more overlapping sections. You attach the hoop to the machine in one position and stitch a
design, and when complete, you move the hoop to the next position, load the next design, and stitch it
creating an overall larger design without rehooping the fabric. For more information on availability for
your machine and how they function at the machine, please visit your local dealer.

X

Program Preferences

Environment
¥ Hoops

Grid Settings 180mm x 300mm
Calibrate Scree :%mmx%%mm

mm x mm
Mouse Wheel 130mm x 300mm Multi
Check for Upda 130mm x 180mm
Ghost Mod 100mm x 180mm (Continuous
DS, cde 100mm x 172mm Multi Delete
&1 Conversion 100mm x 100mm
(1 Files 130mm x 60mm (hat)

Edit

¥ Hotate 50 Select Defaults to
130mm x 50mm (hat)

22 Printing 90 S0mm (avel) i Detauts reset displayed
13 Adjustments e o A e Q

Sewing Field: The design centers are offsetfrom each other:

Width: 172 mm 7.20 cm. Leftto Right

Height: 100 mm

‘ OK | Cancel | | ‘IJ

We have added support for these hoops. When you select the hoop it will be displayed on your screen
- the overall hooped area as well as the hoop section indicators.
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Hoops

1 Embrilliance - Untitled 1 (o ]

File Edit View Zoom Window Help
D EHSe @Y% ¢ B [L)E 8 @ ARl
0.0% 4| e Elil I
& inch z|—|m or . m|a
4 Untitled 1 [0 b | Objects 2@
‘ T P LT T W T T L e g @R 6
""""" <-- Hoop Position #1--> S
__| Properties 2@
""""" =/} Nore |
<am Hoop Position #2--> There are no properies o display
: ~OverAll Hooped Area -
‘Il Zoom: 65% Cursor: 4 "x 1 (7/16)" Hoop: 3 (15/16) x 6 (3/4) 4
Treating this as a standard hoop, you may add lettering, merge designs etc.
[ ! | Embrilliance - Aikcf109_splitbe =i )
File Edit Utility View Zoom Window Help
 mm [0.0% c'l E|>§<|@|
‘ @ inch zl In_n% J Inﬂﬂ |__=| %
Aikef109 splitbe [ b | Objects R
_""'?'N““"‘?"‘"'?*"""50""‘ W 2 "‘3"'-@‘ Tl RE
™ 1 & 1 #% Aikcf109
3 Properties 2 @

Color |

Thread | 1 Color |

Preferred |

1: RA Paly
5597 Snow White

2: RA Paly
9059 Pillows Blue

3 A Poly
5551 Brown

4: R Poly
5596 Black

9094 Candy Tan

< (LI}

3

Click below to change individual colors.

5: Fiobison-Anton Polyester

s

E

Bl A

Zoom: 68% Cursor: 2 (1/2)" x 2 (7/16)"

Hoop: 3 (15/16) x 6 (3/4)

6(1/16)" x 3 (5/16)"

Stitches:19194 Ndls/Cols: 19/28

When complete with your customization, go to File > Save As and choose a name for your design.
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i e 0 o S
@@Qi « Local Disk (C:) » Data » designs » Purchased » adorable ideas » v | ¥4 [l Search adorable ideas L

Organize v Include in library

Essentials o

| Family

| Fonts

| Frogs

| Frogs_Clipartopolis
> | Grandkids

|

|

|

)

)

Jean
KAI
Mary Alice

Pillowcase Patrol ‘

4 | Purchased

3660001 Ziggy des

A Design by Lyn

adorable ideas

All About Blanks

Anita Goodesign

ATG

Balboa Threadworl

Brother Disney carc

Bubbles

Bunnycup Embroid _

l 6 items

e ~

New folder

Burn

Share with ~

0 e

Aikcf109_split Bottom #1.PES Aikcf109_split Top #2.PES

B

111

lf‘ Working file
@ Stitching Info

Aikcf109_splitbe Aikcf109_split TXT =

Multiple files are created for your design. The working file, the stitch files that will be sent to the machine
and a text file containing the stitching instructions which include the order of stitching and location for
each file in the hoop as well as the color order based upon the original design. (shown in Windows Ex-

plorer with Thumbnailer installed)

OBJECTS VIEW

1 Wiy iLetters ”
=2 PN 1039996
21 #_a Cornflower Blue
2:2 Yellow
23 Light Blue
24 Fuged Emerald Green L
25 Pink
2:6 - Fnuct Deep Rose bt

The Objects view shows the designs that have been opened or
merged onto the Design Page and objects within those designs.

Notice that the designs are numbered in the Objects view. The
designs or objects are numbered in the order that they have been
opened or merged onto the design page. In the illustration above
lettering was opened onto the Design Page first. So, it has been
numbered 1. The following merged design is number 2 in the se-
quence. When re-sequencing objects the numbers will change
accordingly.

Using the Objects view designs may be selected, sequenced
and deleted. The Objects view can display individual objects
within designs where allowed. Stitch files (merged embroidery
designs) are one example of a Design Type that allows the display
of individual objects within the design. Clicking on the ‘+” at the
left of the design will expand that design in the Objects view. Un-

der that design will then appear the individual objects.

Using the Objects view, objects may be selected, re-sequenced or deleted.
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Objects View

Auto-Scroll
As you drag on the Objects view, you may come near the top or bottom edge. This will cause the view
to scroll thus enabling you to drag into a position that’s not currently in view.

Selecting
el Using the Objects view you can select any number of Designs or
TS = Objects, regardless of whether or not they are locked, hidden or
Tl = grouped. This allows for editing of objects or designs without un-
1 Hully Letters ®  grouping. For example, the following design is all grouped so that it

can be moved around the page as a single design. However, you may
want to select just the second color to change it, re-sequence it or even
delete it.

=/ 2Py 10399v6

g B R o1 rflower Blue
2:2 Yellow . . ] . .
The toolbar on the Objects view also has selection options includ-
23 Light Blue ing ‘Select All’ which is the first button on the left. If the Main view is
active you can also type Ctrl-A to select all or you can use the Edit

2:4 - Fyge® Emerald Green . .
v menu for this option too.

Objects L]

Reverse Selection

The second button will reverse the current selection. This means that whatever you have selected will
no longer be selected, but everything else will become selected. This is useful when you want to delete
everything except for a single design element.

Range Selection

Using the Objects view you can select multiple designs or objects. If a single object is selected, you can
use the shift key while clicking a second object and this will select a range of objects: Everything in be-
tween the two will be selected.

Disjointed Selection
If you use the Ctrl key while clicking on objects, you can singly select designs or objects. To de-select
an object that’s already selected, Ctrl-click on it. This will reverse its selected state.

Graphical Selection
You can also drag a rectangle around objects in the Objects view to select whatever is in the rectangle.

Note: Dragging enables Auto-Scroll, and your view will move allowing you to select items that weren’t
initially visible.

Selecting by Color

If you want to select all objects of a given color, select one of the objects as described above. Then use
menu option, Edit->Select by Color. This will find and select all the objects on the page which have those
same colors in them. This is a handy feature to change the color of several things at once.

Locking
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If you want to prevent designs or objects from being selectable in the Main View, you can ‘Lock’ them.
Locking an object does not affect its grouping; it only prevents it from being clicked on. The second but-
ton, a white lock with an ‘X’ on it, will not only lock the design or object, but will prevent it from being

displayed in the Main View.

To unlock something, click the third lock, which appears as an open lock icon.

Note: Locking does not prevent you from selecting it in the Object tree, where it can be re-sequenced,

copied, or deleted.

Sequencing

@ Og @ & &
=1} [ 1
o of (@ X (&

1 My Letters

=] -2 P 10399v6

2.1 #__» Cornflower Blue

55 2]
% Move Earlier
2.3 Move Later

Move First
24 1’29 Move Last

THE PROPERTY SHEET

The sequence of objects and designs can be changed using the
Objects view. One way is to right-click on a selected item which
will cause a pop-up menu to be displayed. That menu has options
to move items earlier or later in the sequence.

You can also drag and drop items in the tree to re-sequence
them. Dropping an item (let’s call it ‘B’) on another (called ‘A’)
will place that dropped ‘B’ item right after ‘A’ in the sequence. If
you drag an object onto the design icon, then that drop will be
placed at the head of the design.

You can also re-sequence selected designs and objects using
the ‘Sequence Objects’ command on the Edit menu.

Color | Letters | stitch |

Thread... | | 1 Color... | Preferred l

Click below to change individual colors.

1: Madeira
1080 Orchid

22

When you have design or object items selected, there may be
properties that you can adjust. The Property Sheet contains indi-
vidual ‘Property Pages’ that let you adjust the selected items. The
pages are displayed as tabs. Click on the tab to work with the de-
sign or object items that are selected.

If nothing is selected, the Property Sheet will display the Color
property page, which in turn will show every color in the Design
Page. This is a convenience that allows you to change colors on
the page.

Note: Sometimes, users will confuse the Colors property tab
with the Object View. You cannot select anything using the Colors
property page. This page merely reflects what is selected and lets
you change the colors on display.

The individual tabbed pages that you see will depend on the
designs and objects that you have selected, and we’ll cover those



Color

individual controls in the respective sections for the design types; Lettering, Embroidery and Library de-
signs.

COLOR
“l Color is unexpectedly influential. We may be initially attracted or re-
Color | stieches | pelled by an item or design simply because of its color. The ability to view
rhvead... | [Tcobr. | Proforsd | designs in realistic thread colors isan asset to thej embroiderer. _
Cick Balow to chargs ikl coiors, You may want to recolor a design to better suit your tastes, to coordi-
1: Comflower Blue nate with the threads you have in your stash, or to color a design that
- you've converted from a format that doesn’t hold color settings, such as
2 Yellow .DST.
—— When you merge a Library design, create a lettering design, or merge
a stitch file, the objects come in with the colors and the thread brand that
4 Emerald Green the designer has assigned—even if you have another brand specified as
- preferred (more on that in a bit).
R If the merged stitch file is a .DST file or other format that does hold set
& Desp Flose colors, then threads cannot be matched to any thread brand and will
- simply be a list of generically named colors.
7: Yellow
Tip: If you'd like to get an idea of how your design looks on a particu-

lar color, you can change the background of your main window in Envi-
ronment -> Grid Settings in the Program Preferences.

Changing colors is done via the Color tab on the Property Sheet, which is the lower panel on the right
hand side of your screen. The color tab displays the thread sequence of the design. Selecting a color
swatch on the tab doesn’t select anything in the design; it simply allows you to select and apply a differ-
ent color from any of the thread brands loaded into the program.

When first getting acquainted with Embrilliance, it may be confusing to see what looks like two color
lists. The top list shows a tree-like structure of all the various objects in the current main window. This
includes Library designs, letters, and any merged files. In the sample shown below, a single design has
been merged and the design has been opened in the objects panel so that all the various objects can be
viewed.

Because this is a stitch file, each object is all the stitches that are contained within a given color. In this
instance, when you compare the object list next to the color list, you'll see that they match. For example,
object 1:6 corresponds to color six in the following samples.
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‘ . Color | stitches |
A Thread... I 1 Color... Preferred
=1 "= Owil recolored - I |
Click below to change individual colors.
1:1 - ™= Madeira Thread Chest 1164 Gun Metal Grey 1: Madeira Thread Chest
1001 White
1:2 Madeira Thread Chest 1127 Pastel Peach
1:3 - “=ee Madeira Thread Chest 1000 Black
1:4 Madeira Thread Chest 1071 Winter White

1:5 "B Madeira Thread Chest 1385 Dark Burgundy

1:6 Madeira Thread Chest 1001 White

1.7 ™~  Madeira Thread Chest 1164 Gun Metal Grey

DU | - U b
< >

The color tab will show the colors of the currently selected object(s). If nothing is selected, the list will
show all the colors on the current design page. You can select areas of your design by clicking them in the
object list. You can select more than one area by holding down the Ctrl Key.

2 ARG Color | stitches |
=1 "= Owil recolored % Thread... I 1 Color... | Preferredl
Click below to change individual colors.

1: Madeira Thread Chest
1164 Gun Metal Grey

LR B W2 [Madeira Thread Chest 1164 Gun Metal Grey

1:2 Madeira Thread Chest 1127 Pastel Peach .
2. Madeira Thread Chest

1000 Black

AR N [adeira Thread Chest 1000 Black
3: Madeira Thread Chest

1:4 Madeira Thread Chest 1071 Winter White 1001 White

1:5. "8 Madeira Thread Chest 1385 Dark Burgundy

1:6 Madeira Thread Chest 1001 White

1:7- ™~  Madeira Thread Chest 1164 Gun Metal Grey

R | - SOOI b
< | ¥

The colors list only shows the colors of the selected items.

Thread Brand and Color

There are three buttons across the top of the Color properties tab:

» Thread... Select a thread library to use and set a preferred thread brand

* 1 Color... Make the design monochromatic (one color)

» Preferred Change the colors to the closest match in your preferred thread brand

To change a thread color, simply click on the color swatch that you wish to change on the Color tab.
The Thread palette will open up with the color selected in the original thread brand specified by the de-
signer. You can select a different thread line from the drop down menu and the program will find the
closest match in that chosen thread line.
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M Thread Brand Conversion @
Select a thread brand from the list:

|Madeira Thread Chest _vJ Cancel I
Eg:iz Sylka - his thread brand.
Floriani d
Gutermann Dekar 20
Hemingworth

Isacord Poly

Isafil Rayon

Kingstar

Madeira Poly

Madeira Rayon

Marathon Poly

Marathon Rayon

Poly-%40

Robison-Anton Polyester
Robison-Anton Rayon

Stickma Polyester —
Sulky Ravon NS

Embrilliance includes a wide range of popular thread brands and lines.

Note: In the case of a DST, TAP or EXP file, the Color tab displays a list of generic color names. This is
because these formats have no color information in them. Using Embrilliance you can color these designs,
and when you save the working file, the colors will be saved there.

Similarly, PCS, PCM and HUS formats have limited color palettes. Again, saving the working file will

preserve your colorization, and you can print colorized design templates and color information. This is
especially handy for commercial embroiderers.

Clicking one of these color swatches will open the thread brand that you have set as preferred (Ma-
deira Thread Chest is the default). To change the color, navigate to the desired color and click OK.

Properties « .
Color |
Thread... I 1 Color... I Preferred I
M Thread @ Click below to change individual colors.
Sort by: 1: Black
M R
ladeira Rayon 2 | [l S OK

Search: lE " Number Cancel

276 Madeira Rayon 1110 PN
277: Madeira Rayon 1109

278: Madeira Rayon 1232

2: Blue

3: Light Green

4: Red

5. Purple

279: Madeira Rayon 1031

6: Yellow
260: Madeira Rayon 1235

281: Madewra Rayon 1188
282: Madeira Rayon 1388
v

.DST file shown with generic colors and the thread palette displayed.

7: Gray

8: Light Blue

9: Green

v

Some thread lines only have thread numbers, while others have numbers and color names. You can
search either line by thread number but you can only search by name if the threads have color names.
Type in the color or thread number in the search box and click ‘Go.” Or, you can simply scroll through the
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list and pick one that appeals to you. Once the color is selected, click OK to apply it and close the Thread

palette.
[ — | [ d
Sort by: N

Madeira Thread Chest v oK
@ Color
Search: |1019] E " Number Cancel

14: Madeira Thread Chest 1110 Medium Rose A

13: Madeira Thread Chest 1037 Light Red -~

15: Madeira Thread Chest 1117 Deep Rose 14: Madeira Thread Chest 1110 Medium Rose

16: Madeira Thread Chest 1309 Hot Pink 15: Madeira Thread Chest 1117 Deep Rose

17: Madeira Thread Chest 1120 Pastel Orchid 16: Madeua Thread Chest 1303 Hot Pink

18: Madeira Thread Chest 1107 Coral 17: Madeira Thread Chest 1120 Pastel Orchid

19: Madeira Thread Chest 1108 Mauve 18: Madeira Thread Chest 1107 Coral

20: Madeira Thread Chest 1116 Pink 19: Madeira Thread Chest 1108 Mauve

21: Madewra Thread Chest 1019 Medium Peach 20: Madeira Thread Chest 1116 Pink

22: Madeira Thread Chest 1053 Pastel Mauve 21: Madeira Thread Chest 1013 Medium Peach
v

€

Threads can be searched by number or name.
The ‘Thread... button allows you to change thread brands or to set a preferred brand by choosing a
thread brand from the pop down list. Once a preferred brand is selected, you can easily change all the
colors in any design to your preferred brand by clicking, “Use this as my preferred brand.”

B Thread Brand Conversion

Select a thread brand from the list:
|Madeira Thread Chest ;_l Cancel |

all selected objects will be converted to this thread brand.

Use this as my preferred brand |

A thread brand can be selected on a per-design basis or can be made preferred.

Note: Be advised that while this may be convenient for you, if your design has carefully chosen and
blended colors, converting brands may cause a less than desirable result—especially if a “close match”
does not exist in the new brand.

Left: Original Hemingworth colors. Right: Shown using.Brother Flesh Tones.
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The color list does not name the areas that are colored. For example, suppose you want to change the
pink shorts on the mouse design to blue. An easy way to do this is to find the area in the Object panel and

select it. The color is now isolated in the Color panel and you can easily click it and select a blue.
_— _—

-] 5 Igs00301 -1 5 Igs00301
11 Hemingworth 1006 Gentle Blush 11 Hemingworth 1006 Gentle Blush
12 Hemingworth 1049 Dried Banana 12 Hemingworth 1049 Dried Banana
14 Hemingworth 1006 Gentle Blush 14 Hemingworth 1006 Gentle Blush
15 Hemingworth 1008 Sweet Pea 15 Hemingworth 1008 Sweet Pea
16 Hemingworth 1001 Pure White 16 Hemingworth 1001 Pure White
17 % Hemingworth 1000 Classic Black 17 @ Hemingworth 1000 Classic Black
18 Hemingworth 1049 Dried Banana 18 Hemingworth 1049 Dried Banana
19 Hemingworth 1009 Rosy Blush 1.3 T Hemingworth 1009 Rosy Blush
T 3
Color | Color |
[vesi | [Tcoo] eroemsd [vesi. ] [Tcaor ] prtemed |
Click below to change individual colors. Click below to change individual colors.

1: Hemingworth 1: Hemingworth
1003 Rosy Blush 1188 Hyacinth

Coloring Letters

Coloring Letters works a bit differently. To color individual letters, click on the center of the letter to

select it. Then, as before, click the color swatch to select a new thread color.
Color l

Thread... | lColor...I Preferred

Click below to change individual colors.

1: Madeira Poly
1675

Color Sorting
The “Happy Birthday” design has 6 unique colors but 13 color stops. To make it more effi-
cient for sewing, you might like to optimize the sewing order to reduce extra color changes.
- Because letters added together are considered one object, you can’t selectively rearrange
them in the object tree. Fortunately, there is easier method accomplished via Color Sort, which can be ac-
cessed on the toolbar just to the right of the Undo and Redo buttons.

Clicking the Color Sort button displays the following dialog window:
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I Color Sort

- BX

The design page has been reduced by 5 color changes. | Save It... | Cancel I

/f ?‘x PPY
SIRTHDAY

Notice our design has been reduced by 5 colors.

"'~

Click ‘Save It..." to save the color sorted file as a stitch file. If you don’t change the name, the program
will append “_sorted” to the end of the current file name. Your original working file (.BE file) is preserved
and not changed.

Color sorting can be useful in designs like this or designs that have poor sequencing. Color sorting
in this program is intelligent, meaning it doesn’t indiscriminately combine all like colors together. It looks
for layering and knows that some colors simply must be repeated.

Note: Do use caution when color sorting. Some designers have intentionally added extra color chang-
es either for design flexibility or to optimize registration. For this reason, always Color Sort a copy of a
design!

THE THREAD EDITOR

The management of threads is a challenge for every embroiderer. And every embroiderer handles
this differently. Some people are very organized and will colorize designs with only colors they actually
own. Others resist changing threads at all. And of course commercial embroiderers ignore colors on-
screen entirely and just run whatever colors the job calls for.

The Thread / Palette Editor provides a place for you to manage which threads you own, create
smaller palettes for specific projects, and even share those palettes with others.

When choosing colors in the main program window, you are given the choice of picking colors
from thread lines or palettes. The reason for this is to allow quick access to a current set of project colors,
rather than taking the time to scroll through a long list of threads and their complete color lists. Often, an
embroiderer is working with a set of colors repeatedly and selecting through a long list when you, “Just
want that blue I'm using,” would be tedious. For this reason, there is a checkbox that is used to determine
whether the color list is shown as a thread or a palette.
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Merging colors from different thread lines / palettes.The Thread Editor

|| w2 [

Narne: I Coats and Clark Poly j

Colors -
Sort: @ Color ¢ MNumber " MName

Display: | Hidden
Motes:

Selection:  Check |Uncheck| Delete |

1: Coats and Clark Paoly
5 Copenhagen

[>

2: Coats and Clark Poly
510 Radiant Blue

3: Coats and Clark Poly
420 Comflower

4: Coats and Clark Poly
4 Blue

5: Coats and Clark Poly
1324 Parakeet

E: Coats and Clark Poly
44 Medium Blue

7: Coats and Clark Poly
1224 Blue Aqua

8: Coats and Clark Poly
3 Ciel

v

Note: For the purposes of discussion, the term “thread line” and “palette” are considered synony-
mous, except when discussing the above checkbox.

The program ships with data for many thread lines, including some that may not be available to
you in your area. If you would prefer not to have those threads show up in your list (while changing col-
ors in a design), you can check the box labeled, “Do not display.” This does not hide the thread in the
Thread Editor, only in the Thread and Color properties when working with designs and objects.

The ‘Notes’ box can be used to enter any useful information about a particular palette. For in-
stance, you might create a palette of colors for a particular job or project and you can enter information
such as “The blue design matches the print on the front of the shirt.”

Each thread brand or palette is stored as a file on your computer. As such, the toolbar has options
for you to create new thread palettes, save a palette which you're working on, and even delete a palette
that’s no longer needed. These actions are performed by the left three buttons on the toolbar.
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Merging colors from different thread lines / palettes.

The next button, ‘Merge’ will open a thread window that lets you select one or multiple colors to
be merged into the current palette. Also, there is a Delete button which removes any selected threads

from the current palette.

M Thread

Wie: |Madeira Thread Chest ﬂ
 Threads | sgetr & color ¢ Mame ( Wumber

" Palettes
Search:

3 Madeira Thread Chest
1386 Dark Chestrut

4: Madeira Thread Chest
1181 Baybemy

5 Madeira Thread Chest
1381 Dark Mulbery

X]

[

-~

Multiple selections can be made
using the Ctrl and Shift keys while se-
lecting with the mouse.

6 Madeira Thread Chest
1183 Magenta %

¥ Madeira Thread Chest
1115 Medium Burgundy

2 Madeira Thread Chest
1281 Mulbermy

3 Madeira Thr_ead Chest w

When merging colors from another thread or palette, the ‘brand’ for those colors will take the
name of the current thread. This is one difference between a thread and a palette. If you merge colors into
a palette (the palette box is checked) then the colors will keep their original thread names.

Sharing Palettes

If you would like to share or import a palette, use the two buttons on the right of the toolbar. Shar-
ing a palette is great when you are making a project that others will make too.

Thread Inventory

You can mark threads that you have in your personal inventory using the ‘Check’ and ‘Uncheck’
buttons:

% Thread f Palette Editor

. BX | ++
_u‘E|® Lﬁ‘ H‘BX
Calars
| Coats and Clark Pal
HEITS | ¥ j Sark: ¢ Color O Mumber O Mame
Display: | Hidden Selection: | Check ;l Llrn:heck| Delete |
Motes: kg
1: Coatz and Clark. Paoly Y
5 Copenhagen =

&t Coatz and Clark, Poly
510 Radiant Blue
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Fit to Hoop

TRANSFORM CONTROLS

Sizing and positioning of design elements can also be accomplished using the Size and Position con-
trols panel located on the Tool pane. The first control on this panel sets the unit of measure for the design
page. The choices are millimeters and inches.

& mm | *|30038 | 100.0% o ‘}|{‘| = |
Coinch | ¥ [102z [100.0% |0.0° | =3

The width and height of a selected design element can be precisely set by entering the desired value
in the width and height text box and pressing the enter key. If an exact size is not known, the element can
be sized as a percentage of its original size by entering a percent value in the percent text box and press-
ing the enter key.

WM 26,37 g5,2%:

I | 24.35 5. 2%

These controls are also updated as a design element is moved or re-sized using its handles.
The element is scaled proportionally if the Scale Proportionally control is locked, otherwise height
and width changes are applied individually.

s

Locked—Scale Proportionally

Unlocked—Scale Height and Width Individually

Note: If you have sized an element and want to return to its original size, simply lock the Scale Pro-
portionally control and enter a value of 100 in either of the percentage fields. Embrilliance will remember
the original size even when you reopen the design at a future date.

Mirror and Rotate

The next four controls mirror and rotate selected elements. Mirroring is about the horizontal or verti-
cal axes. Rotation is clockwise or counter clockwise in 90 degree increments with the pivot point in the
center of the selection. Alternatively, you can enter a specific value for the degree of rotation. Enter a pos-
itive value to rotate counter-clockwise and a negative value to rotate clockwise.

Bk
0.0°

Centering In the Hoop

Centering in the Hoop can be accomplished by this button, although it is not necessary because,
ﬂ as arule, designs are centered when stitch files are saved. This is also available from the Utility
menu.

Fit to Hoop
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Design elements can be scaled up to the design page by selecting them and clicking the Fit
@ | Hoop tool. This will recalculate stitches wherever possible. There are limits, though, such as with
regular embroidery designs, which can only be sized up to 250%. This button will scale your de-
sign as large as it can go, up to the built-in limits.

Remove Hidden Stitches

A When designs are overlapped, there may be stitches that are hidden, which you would like to
\AQ have removed. This process is automatically done when you save a file (controllable by prefer-
ences) but you may want to preview the results before saving. The Remove Hidden Stitches will
run the process on those stitches so that you can evaluate the result. The result is temporary, however, so
if you change anything on the design page, the stitches will return. This happens because changing a de-
sign will almost always regenerate its stitches.

Align and Distribute

) Alignment of multiple items can be set using the Align button, which will open the Align and
=] Distribute window. Alignment will place the edges or centers of designs all on one line.

Align and Distribute @ Align and Distribute @

dlign | pistribute | Align  Distribute |
- c1 = Bl 1] ]
= <5 £ o m] o (m] = m] a a
v ; z
[ ore [ Conter I Right [ Left ™ Center [ Spacing | Right
= [ To
04 T Top o P
ED V¥ Center ' Extent of Selection
nh v
o4 W Center [ Center on Page o = ) £ Extent of Hoop
== Spacing
B¢ T Bottom _DEI [ Bottom
Apply I Close | Apply I Close I

If you have two or more items selected, you can align them. For example, these items are Aligned Left:
""""" R e A S .
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Stitch Files

Distribution is different from alignment. Distribution places designs equidistant across a distance.
This is useful if you want to make regular patterns, such as a tiled design. If you would like items distrib-
uted across an area, move the first and last items to the outside areas that you want to fill. In this exam-
ple, the (top, left) ‘A’ and the (bottom, right) ‘A’ make the design size. But notice how the ‘A’ designs be-

5

Using ‘Center’ distribution will distribute these letters evenly, based on each letter’s center.

If you choose a different edge to distribute with, for instance, Left, then the distribution will be made
using the left edges of all the designs. This can be useful to create a geometric composition with different
sized designs.

STITCH FILES

Clicking the Merge Stitch File tool found on the Design Toolbar or selecting Merge from the
ﬁ Il File menu will display the Open Design Files dialog. Here you browse for embroidery designs to

add to the Design Page.
- =
B Embrilliance - Untitled 1+ L il el _—
Edit Digitizer “iew Zoom ‘Window Help- E U "ﬁ" a
Mew Page Ctrl+H [ e o IR
Open.. Cirl+0 Himaa: 1~
Close Lol
Lo
Sawe Ctrl+5 =l
Save As.., - . In-u
T = a
Save Working File... ILize- -clla -
o Peer b ol v
Save Wiorking File As.., _:I il ode =
Merge Warking File.., 1 stadt A -
. ] Licatd -Eu
Wl Stitch File... :
Erge sHkeh e % L - R H
Print... Ctrl+P - e |
F BEL E R TR
Print Previens = cEAR g ma
oryk 3 Iy
- BT R — H A ]
| lm.ph
L I}
I EN Y R
Lormo A
B O] (LN
e b wmiaday —!

The Merge Design view allows you to browse thumbnails
of your files and select one or more files in import.
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» The Size control of this dialog determines the preview size of the design thumbnails (the design
does not have to be selected for the determined size). The 3D control shows the preview in 3D, i.e.
it shows simulated stitches.

* Click the Import control to bring the selected design(s) into the Design Page. The imported design
will be centered on the Design Page.

Merged Stitch File behind Monogram.
Size and Move

The lettering, the Library designs and the merged stitch files can all be sized and moved.
Existing embroidery files can be resized with stitch recalculation. You can resize embroidery up to
250% and down to 50%. If you want to resize an existing design without stitch recalculation, hold down
the Ctrl key while dragging the handle.
* Click and drag on a black handle to resize the design.
* Click and drag the round blue handle to rotate the element.

Black handles resize, round blue handle in upper right rotates.

Click and drag anywhere on a design element to move it. As the design is moved off the page, in
any direction, the page will automatically scroll if the cursor is in the ruler area of the page. For finer
movements (1mm at a click), the selected design element(s) can be nudged using the keyboard arrow
keys. To move objects one stitch point at a time (.1mm); hold down the control key while pressing an ar-
row key.

When resizing, understand that not every design can be recalculated perfectly. Some designs such
as cross-stitch and freestanding lace are not going to resize correctly. Another consideration is the level
of detail. Highly detailed designs radically reduced will lose clarity and crispness as the details become
squished together.

Note: This is one major benefit of the Library designs; they can usually scale and calculate their
stitches for you.
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DELETING STITCHES BY DELETING A COLOR

Often you will want to delete a section of stitches from a design that has been merged. When those
stitches are all grouped as one color this is easily accomplished using the Object View. Open the design
using the ‘+’ in the tree. Next, select the color you want to delete. Next, choose ‘Delete’ from the Edit menu
or use the ‘Delete’ key on your keyboard.

Below, the first color of the design is selected. Simply press ‘Delete’ on your keyboard to remove the
first color along with the stitches associated with it.

Note: Another way to delete is to use the menu, Edit->Delete.

o ik

% @ QG 2 oo @ R G

=| 2N 10399v6 _ =2 e 103996 =
b B P i owver Blue 21 Yellow
2:2 Yellow 2:2 Light Blue
2.3 Light Blue 2:3- Byge® Emerald Green
2:4 . Fyge® Emerald Green 2:4 Pink
25 Pink 2.5 Faget Deep Rose
= v
Left: Color is selected. Right: Color has been deleted.

PROJECT ADVISOR

The Project Advisor is a patented expert system, a form of artificial intelligence, which helps
you select stabilizer, needles and hooping techniques for many common projects.

The system also provides instructions, helpful how-to advice and some words of caution
when necessary. First, you select a project from the list. If your exact project or fabric is not listed, there
are enough choices available where you can choose something very similar. Next, you can tell the Advisor
if your fabric has more or less stretch, and you can adjust thickness. The Advisor takes your input in ac-
count as it makes its recommendations, which are displayed as text in the window.

Project Advisor @

Please select a project/fabric type:  Recommendations;

Cotton/Poly/Lycra ~!  Needle: Embroidery, size 11-12

You may akso modify the settings; 1 hread: 40wt

Fabric thickness:  |Medium v | Backing: fusible tear-away or water-soluble
self-adhesive

Fabric stretch: [A Lot v

Project Notes:

There are many variations of this blend on the market. Some have no polyester, whereas some are just poly/lycra
blends. This particular fabric aroup is usually made for workout clothing. If this is what you are doing, then also see
the section on Lycra. If your intention is to have the fabric worn or used in a more relaxed state, such as with a skirt or
loose-fitting top, then these instructions are more appropriate. Note that if you use a stabilizer with adhesive, try a
titanium needle, as the residue from the adhesive will not build up as easily on it.

Hooping suggestion: Tightly hoop the backing, then baste the fabric and topping to it.

Both the backing (under the fabric) and topping (on top of the fabric) stabilizers are recommended.

DRK users will also have the Project system, which extends the Project Advisor settings to actually
adjust your designs’ stitches for the chosen project.
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OTHER PREFERENCES

There are a number of preferences for the program and design page that can be adjusted. Click on the
Preferences button to reveal these controls.

Embroidery Hoops

:
Progam Prfrences smp—————— L,

Environment
% Hoops |PES
Grid Settings 180mm x 300mm

Calibrate Scree 160mm x 260mm
150mm x 150mm

Mouse Wheel 130mm x 300mm Multi
Check for Upda 130mm x 180mm

Gh 100mm x 180mm (Continuous,
Os_t Mode 100mm x 172mm Multi
1 Conversion 100mm x 100mm =

130mm x 60mm (hat) Select Defaults to
130mm x 50mm (hat)

intl 90mm x 80mm (oval) i — reset displayed
L1 Adjustments £ o Al hoops

Sewing Field The design centers are offset from each other.

Width: 172 mm. 7.20 cm. Leftto Right.
Height 100 mm
< | 1 | »
0K | Cancel ‘ ‘

In the Preference window, under Environment, you can choose a hoop. Hoops are displayed in a sort-
ed list, organized by embroidery file format. Most embroidery hoops are made using the metric system,
so the sizes for the hoops are displayed according to the way the manufacturer sells the hoop.

There are many hoops that are built into the program, and you can add your own. As the program up-
dates over time, or if you have edited a hoop, you can use the “Defaults” button to restore the program to
the hoops provided. The “Default” button will not, however, remove any hoops you've added yourself.

Some manufacturer multi-position hoops are listed - they have “Multi” listed after the size. Designs
will automatically split upon the Save and a text file will be created with the stitching instructions. See
the section on “Notes on Multi-position hoops” for more information.

Many times you will want to sew a design sideways in the hoop. But rather than laying out your de-
sign sideways, it might be convenient to have the hoop displayed as rotated. Checking the “Rotate 90"
button accomplishes this.

If you have added a hoop, or if you decide to have the program display only the hoops that you own,
you can delete hoops from the list, using the “Delete” button.

You can create hoops and edit hoops too.

MName: | 200mm x 300mm
Width {mm}): 200
Height {mm): 300

|

The width and height fields are self-explanatory, and you can name your hoop as desired. Hoop names
should be unique.
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Note: Do not create a hoop that is bigger than the sewing field of your embroidery machine.

File Conversion

Designs can be saved into many different formats. The Conversion Preference allows you to adjust
some parameters when you save in those different formats.

Program Preferences
(C3 Environment =
== F t: i
= ormal PES v (¢ Use version S and later for real threads
) i " Force version 1
v anversmn Maximum Colors: | 127
Stitch Format Machine specific:
(2] Files
&3 Printing [~ allow 180x 300 hoop (PES v6)
(23 Adjustments I write file for 6 Needle when required

The file format itself may have inherent limitations on the number of colors or stitches, such as the 16
color limit in .PCS. But there are also machine limitations too. Older machines that use the .PES format
had limits of 100 colors, whereas the newer ones can go to 127. To help you save files correctly for your
machine, there are options for some formats, such as .PES.

PES Files have to support two distinct machine types, and also have different data for the support of
card reader/writers that many .PES machines required. Let’s look at the .PES options more closely.

“Use version 5 and later for real threads.” This setting exists because the version 5 of the Palette/PE-
Design software, which invented the .PES file, added support for real thread colors. This was a wonderful
addition for this format. However, if you own an earlier version of the software, and you want to use files
created in Embrilliance, then you need to leave this set to “Force version 1.” The reason is simple: The old
software simply cannot open those version 5 files.

The machine specific settings are for machines like the Ellegante, which takes the 180 x 300 hoop
(while other machines may not be able to accept this hoop, so why write a file for it.) Or the multi-needle
machines, which have their embroidery field rotated to a landscape position. So a 200x300 or a 300x200
field, while technically the same size, have different rotational parameters.

Certainly you know if you have a multi-position machine, or require the use of older software to write
your card. If not, or if you are distributing these designs, please just leave the settings as-is. The program
actually finds a Lowest Common Denominator in the format that it will output, making the file available
to the widest range of users.

ﬁu

(3 Environment

A

=3 Conversion Format: |DST X
% Conversion :
Maximum Colars: |0
Stitch Format
(] Files
(23 Printing Commands for trim: | 3

(1 Adjustments
IV Ensure Trims after: | 127 stitch pts.

DST and EXP Files have a different type of information contained in them where it pertains to jump
stitches. Rather, those formats have to have some number of “Jump” commands in a row before they will
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cycle their thread trimmer. When making a DST file, and converting from something else, these jump
commands need to be translated. As machines differ in setup for the number of commands needed to cy-
cle the trimmers, we offer this setting in the conversion preferences.

Preferred Stitch Format

Most embroiderers have one machine or other that they use most for embroidery and that machine
has a format that it uses. To save time, the format that you choose here will automatically be selected dur-
ing the save.

Program Preferences

9 Enwronrr'!ent Format: |pgs « | Setthis as vour preferred stitch Format, which

Conversion gets saved along with a working file when you
Conversion choose 'Save from the menu,

Pl Stitch Format

(] Files

(2] Printing

(C] Adjustments

OK I Cancel I Apply I

Note: Even though you have set a preferred format, you can still choose File > Save Stitch File As if
you need to occasionally save in a different format. After selecting a new format in the ‘Save As’ dialog
box that format will “stick,” over riding the Preferred Stitch Format until you either reselect the preferred
one or a new one.

Note about SHV: Setting the preferred format to SHV does not create the file structure your machine
may expect to see. To create a proper Designer 1 diskette or stick, please read the section on Creating A
Designer 1 Disk or USB Stick.

Removing Overlaps Preference

When creating a composition, you can arrange designs so that they overlap. Embrilliance automatical-
ly removes the overlapped stitches using our patented system. When you save your design, the stitches
will be automatically removed. If you prefer this not to happen, uncheck the box and click Apply.

Program Preferences

(Z3 Environment
(Z] Conversion
‘=3 Files
% Remove Overlaps
Auto Recover
(2] Printing
(] Adjustments

[V Remove overlaps when saving stitch files,

OK Cancel Apply
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Auto Recover

Auto recover will save your file in a separate space every so often. This is adjusted using the slider.
This feature is useful when working on a complex arrangement where a power outage or program crash
(unlikely) or freeze by the operating system (it happens) could force the program to quit and you might
lose your work. If you are working while power-outs are happening, well, turn this on. And don’t run your
embroidery machine; brown outs are not good for them.

Checking For Updates

The program can check for updates if it is running on a system connected to the internet. This will oc-
cur once each day, the first time that you run the program. The program does not send your information
or anything about you or your computer to us. It merely checks the current version available online for
your program and if there’s an update, it lets you know. If you don’t want this, you can turn this off.

You can also check for updates at any time from the option in the Help menu.

CREATING A DESIGNER 1 DISK OR STICK

If you have a Husqvarna Viking Designer machine that uses either a USB
stitch or a 3.5” diskette, you can create the proper files and file structure via Util-
ity -> Designer 1 Disk Utility.

When the Designer 1 Disk Utility window opens, you can choose whether
you want to write to a diskette or a stick. Next, choose which menu you on which

BN View Zoom  Window

align and Distribute. ..

e LD ity you want to store the designs. Designs are imported to only one menu at a time.
Threads... M Designer 1 Disk Utility
T (¢ Diskette (" USB Stick Drive: |C:\ v| Read | Write
—m Get Designs...

Menu 2 -

Menu 3 Save Designs...

Menu 4 Remove Selected

Remove Al

Click the ‘Get Design...’ button and navigate to the desired designs. You'll see the now familiar ‘Get De-
signs’ window where you can select individual designs or the entire folder to import.

Note: Each menu can store up to 36 designs. If you select more than that to import, only the first 36
will be imported.
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M Open Design Files X

008

e Sel.

-

Import

Browse |
= (@ Desitop
4 () My Documents
% 1§ My Computer
+ % My Network Places
* 2 Apps

# 1 lgs002vp3
() Ragdoll Critters
) Revisions

) EmbroideryWorks1102Setup-1.2ip
Revisions. zip

L < B - <> I > <

C:\Documents and Settings|Owner|DesktopMyDesigns\Ragdall Crittersligs00301.PES Size: 95.00 x 86.20(mm), St: 12650, Col: 9

M Designer 1 Disk Utility X

(+ Diskette (" USB Stick Drive: [y v| Read | write
Menu 1 lgs00301.PES Get Designs...
Menu 2 lgs00302.PES _
Menu 3 lgs00303.PES Save Designs...
1s00304,PES s
Menu 4 1gs00305.PES emove Selecte
1gs00306.PES
1500307 PES Remove Al
1gs00308.PES
1gs00309.PES
1gs00310.PES
Grid: 4x3

The designs are imported with their original file names and file types at this point. To finish the pro-
cess, click the ‘Write’ button. Navigate to the desired destination and click ‘Select Diskette.’

When you view the newly created Designer 1 media, you'll see the files are renamed appropriately
and all the necessary support structure is also created.

Tip: You are not required to write to an actual diskette. If you create folders ahead of time, you can ac-
tually “write the diskette” into a folder on your hard drive for copying onto a diskette later.

Similarly, Designer diskettes and sticks can be read into Embrilliance by clicking the ‘Read’ button.
Note: If you want to add files to a previously created Designer diskette or stick, you will need to first

read in the designs and then add the new files to one of the menus. When a Designer disk or stick is writ-
ten, it replaces any matching file and folder names.

LETTERING
Creating a simple letter design or monogram is, well, simple! Just click the Create Letters
ﬁ tool found on the Design Toolbar. This action will place the new lettering in the center of the de-

sign page and display the Letters Property tab.
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% A @l

Design Toolbar

Monograms vs. Letters

Traditionally, monograms were a single letter—“mono” meaning one and “gram” referring to the let-
ter. Today most monograms are 3-letter combinations with the center letter larger than the outer two.

Fonts or letters styled specifically for such monograms are prefixed with “MGM” to easily distinguish
them from more standard fonts. Of course, you can make a monogram with any font style and use the en-
veloping features to shape the design.

Monogram using MGM Diamond

Properties n @
Color  Latters | Stitch |

Text: | ABC

‘ sge MG Diamond jj
SQtusjﬁak ‘ABC Mormal j

sy e <]

Slant: J— ﬂ
= ﬂJ

o [ =] — —
o =

Space:

Bottom:

Monogram Properties on the Single Line Page
Now, set the monogram to your desired value by typing into the Text box and pressing the ‘Enter’
key.

Properties n @
Color  Letters | stitch |

=I5

Single line of text or Monogram

Monogram
=T

ABC

Selecting Letter Type

Although the fonts prefixed with “MGM” are designed for traditional three-letter monograms, you are
by no means restricted to three letters. For example, if you just want the large center letter, enter a space
and the character you want.
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Type a space before a letter for a large single letter

For fun, you can use a monogram font with entire words. This method works best with all capital let-
ters and shorter words.

Sample above uses MGM Rounded applied to a word.

Overlapping letters is sometimes needed for your design, and when you do that within a lettering ob-
ject, the stitches that are hidden will be removed automatically:

Customize the Design

The Letters Property tab provides a number of tools that allow the design to be customized.

There are three basic styles for lettering:
* Multi-Line Text
— ='| O | + Single line of text or Monograms
» Text on a Circle
The lettering design can switch between these styles using the three buttons at the top of the property
tab as shown above.
Multi-Line Text is useful when you want to enter an entire saying, poem, etc.
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This is multi-line text

The little dog laughed
To see such ...

etc
Text: |F'.BC
‘ ABC Elock, j j
gtuw:,.!i;k ‘ABC Marrnal j
Srdery |EC =

Slant: —J— ﬂ
Space: —J_ ﬂ
Top: Curve - —J_ ﬂ slider.
Eotbom: |Curve - —J— ﬂ

)
£ O

W ¢

Lettering

BBC

et

ABC

" Lefr

Slant:
Space;
Ward Spc:

Line Spc:

Block, j j

+ Center ( Right

i ] i i [ i

Spiral text starts in the center.

When writing on a circle, you have the option to put text either
on the inside or outside; when embroidering, we usually think of
this as text at the bottom or top of a circular patch or badge. To

switch this, use the checkbox labeled “Place on bottom.”

Monogram Font and Quick Style

)
Q

Single line of text or Monograms is useful for entering a single line of
text or a Monogram. With a single line of text there is more flexibility in
the shape such as the enveloping feature. With Monograms there are some
fun Quick Styles that re-shape the 3-letter monogram and when overlap-
ping the monogram letters the Sewing Order finishes the look.

Text: | ABC

[ Place on bokkom

‘ A B c Block.

Radius: 100.0mm = 3 {7/a)"
|

4]
Slant: _} ﬂ
Space:! Jl ﬂ
Wiard Spcs Jl ﬂ
Line Spc: Jl ﬂ

Circle Text wraps around a circle. If you overflow the amount of letters
that can fit on the circle, you will see your text spiral outwards. To see the
text on a circle, you will have to adjust the ‘Radius’ of the circle using the

0©eS
d
00

The font and style are changed using the selections in the Font and Quick Style boxes.
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Properties ¢ .
Color  Letters | stiech |

=l=] 0

Text: [ ABC

‘ ge MGM Diamond j j
gl.::lc:: ABC normal
Sewing ABc

Order:

-
~

A .
Slant: g Vertical

Space: E Square Left

B
ol CA Square Right

Boktom: ABD Oval v

Quick Style menu

When the lettering is initially placed on the page, the letters are automatically kerned (letter spacing)
for a good visual effect. Note that these styles are designed to accomplish traditional monograms, and
therefore some only work properly with two or three letters.

Font Selection

Some fonts may only have uppercase letters. If you're using a font and not seeing the desired charac-
ters, clicking the ‘7’ button to the right of the Font box; it will display all characters available in the select-
ed font along with size recommendations.

Available Characters @ Available Characters

2 Block. b MGM Diamond

</ </
ABCDEFGHIIKLMNOPQRSTUVWXYZ ABCDEFGHIIKLMNOPQRSTUVWXYZ
abcdefghijklmnopgrstuvwixyz Minimum recommended size:  20mm
0123456789 Maximum allowable size: 200mm
V"#E%RE (), - [y <=>r@[\ ]~ _{}
Minimum recommended size:  Smm
Maximum allowable size:  7Smm

Characters available shown with recommended size ranges.

Slant and Space

The slant of the monogram and the spacing of the monogram letters are controlled with the Slant and
Space slider controls. If you use these controls and want to return the monogram to its default settings,
simply click the zero control. This will restore the default setting. The Slant gives an italic effect to the
monogram.

Slant: j
Space: j

Enveloping

The envelope (containing top and bottom outlines) of the lettering (single or multi-line) can be individu-
ally customized. The Envelope Type box and Envelope Slider control the envelope. There is an Envelope
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Slider control for the envelope top and there is an envelope slider control for the envelope bottom. There
are four styles of envelope: Curve, Grow, Peak and Shrink.
If you use these controls and want to return the lettering to its default settings simply click the zero

control.
Top: CUrwe W j Y
Boktom: | Curwe W j p E

Enveloping

Curved Top and Bottom Envelope
Enveloping can produce a variety of creative designs, especially when you begin breaking up the
words into segments and enveloping each one separately.

500

HING

“_n

Sample above uses two envelopes and a lower case “0” resized for bubbles.

Changing the Color of one Letter

You can change the color of one letter by selecting that one letter. To select it, first make sure the let-
tering object or monogram is selected, then click on the green handle that appears centered over the let-
ter you want to change. Once a single letter is selected, you can change the color(s) of just that one letter
using the color property page as described previously.

For more information on threads and colors, see the section on Color.

Monogram Sewing Order
On the Letters tab there is a Sewing Order box. Choose the order in which the

s |sien | "B letters are sewn from this control. For a simple monogram you probably do not
=l— o want to change the default order. However, if you want to overlap the center let-

Text: [ 6C ter on the others, you could choose the ‘ACB’ order (second choice).

‘ ARt MGM Diamord jj

S | ABC noms -

vy [P =

A-B-C
Slank:

B-A-C
Space; [B-C-A

4B
Top: IC'B'A

p— | H o— |
Eiottom: 4 _| -0-

Stitch Properties
The Stitch tab contains controls for the actual stitch generation of the Lettering.
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Note: This tab will not be displayed for imported fonts, as those designs are different in nature.

Properties I
Caolar lLettels Stitch l

Satin Density: [0.1mm): |4 ill

Compensatior: (0. 1mm): |0 ﬂ
[¥ Remove Hidden Stitches

Satin Underlay:
v Edge Fur
Inget (01 mm) : lﬂ
[+ Satin

Density (0.1mm] : [18 :II
Set Defaultz

Satin Density Control: This control ranges from 3 to 20 with each tick being one tenth of a millime-
ter. So the range in millimeters is .3 to 2.0 mm. The smaller the density number the closer together the
satin stitches will be. 0.4mm is normal.

Compensation: This control ranges from 0 to 10 with each tick being .1 millimeter. As the value in-
creases the stitch length increases, in effect ‘fattening’ the stitching. This is useful on fabrics that have a
loft or nap, and can also be used to make a font appear bolder.

Remove Hidden Stitches: When selected, stitches that are completely hidden by top stitches will be
removed. This process allows the design to sew out in a flatter manner. Note that this only affects stitch-
ing within the monogram itself.

Edge Run: When checked, this adds a running stitch underlay. This setting is the amount of inset for
the edge run and ranges from .1 to 1.2 mm.

Satin: When checked, this adds a satin underlay. When checked, it applies the density value, which
ranges from .3 to 2.0 mm just like the satin stitch.

The Set Defaults button restores each of these controls to their default values.

Text Path

You can manipulate the text to form a shape or path. Each letter has several
handles to accomplish this. Click on a letter’s center green handle to select that
letter.

The center handle will move that letter.

The green pennant handle on top of the center will stagger the letters from that
one forward:




Lettering

The blue handle at the center will rotate the letter and all subsequent letters. And the green pennant
under the center handle will move that letter and all the letters on the line following it.

Using these handles, you can make your letters into virtually any shape.
A Closer Look: You can manipulate text to fit virtually any kind of path using the handles for the text de-

sign as well as the individual letter and rest-of-line handles. The letters have additional control handles
which display when the monogram is selected:

.

- u Letter Size and Rotation: As with any design, the letter itself has

N four black handles for resizing, and a blue handle at the top, right used

to rotate the letter on its own.
End-of-Line Handles: Note the Center Green Handle in each letter.
a
47
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This handle that appears in the center of a letter when the lettering design is selected and it is used to move
the individual letter. Simply click on it and drag the letter to the desired position.

Clicking the center green handle also allows you to change the color of that letter only, leaving the
others untouched. Use the Colors page in the Property Sheet to change the letter color, as you would
change any color layer in a design.

Clicking on the green center handle will display three additional handles. These handles give a wide
range of control over the positioning of the letters. The handles work on the selected letter and all letters
to the right of the selected letter. Let’s take a closer look at these handles:

Top Green Handle: The handle over the center handle is a line stag-
ger. This handle staggers the letters vertically and changes the spacing
simultaneously. The example shows a stagger upward.

Bottom Green Handle: This handle is the kerning handle. It can be
~ used to move letters beginning with the one selected to the end of a line.
This handle moves the letters to a new location without affecting the
spacing on anything from the selected letter forward to the end of the
line.

Center Blue Circle Handle: This handle is another tool that

n n’ moves all text until end-of-line. This handle rotates the letters around
H the center of the selected letter.
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The Embrilliance Library

THE EMBRILLIANCE LIBRARY

Clicking the Library tool found on the Design Toolbar will display the selection dialog. The
(f-;-\ dialog has a scrolling list on the left that shows the collections. Select a collection from the list
- on the left and designs in that category display in the selection area on the right. Select a design
and click OK. The design will be placed in the center of the Design Page.

"=

r
Selection

-

'@, 4

Applique Frames 1 w

Frame 1 Frame 2 —

9

Frame 3 Frame 4

m

Frame/Design Thread Brand and Color:
The thread brand and color are changed just as described in Color section.
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STITCH SIMULATOR

The Stitch Simulator lets you see how the design will sew out by sewing on the screen. It is activated
by clicking the Stitch Simulator tool in the View tool bar or selecting Stitch Simulator from the View
menu.

Stitch Simulator controls

mZDDm Window  Help

| Toolbars and Windows.., » 4

! v Metric

| w Draw stitches in 30 ]
Draw Hoop 1
| v Draw Grid

I
i

Stitch Simulator
Hoop Size...

F

Stitch Simulator Controls
The controls are easy to use and give complete control of the simulated sewing process.

Player Control: This control lets you sew forward, backward and stop. The right arrow starts sewing
forward. The double bars stop sewing. The left arrow starts sewing backward.

Step Stitch Control: This control lets you sew one stitch at a time forward or backward. Right arrow:
forward. Left arrow: backward.

Speed Control: Use the slider to change the speed of sewing. Move to the left for slower to the right
for faster.

Manual Control: Click and drag this slider forward or backward to quickly move a particular section
of the design.

=g

Stop Control: Click the Stop button to insert a color stop in the design. This allows you to change col-
ors on the fly. Or creatively use this to isolate parts of the design that you want to remove or isolate.

O
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BASTING FUNC

TIONS

Basting functions

N View Zoom Window
Center in Hoop
align and Distribute. ..

Color Sort...

Baste Design...
Designer 1 Disk Utility. ..

below.

M Embrilliance - Untitled 1 *

V' Threads...

Fle Edt Utity View Zoom Window Help

BHdob@P ¢ijwAdHvE S AR

EExR

-

T
8

G oom ™ 0.0% a o el B

Cioch [ [oo% 0.0° LIRS

4 Untitled 1 * (3 v B

ARERSRA RS RPN RN AR SRR RS ] #,\ %% 0 8 G
:; ® + |\:]

= ‘ ¥ 2y wbooros
o -

[ _L %3 * Igb00708
= %4 ala whooros
Fn & 5 Igh00714
:: Y sG Igh00701

Zoom: 60% Cursor: 113.0mm x 61.7mm

M Embrilliance - Untitled 1 *
Fle Edt Utity View Zoom Window Help

BHdou@P 2 |wItvE S AR

Com ([ o, 9]¢
Cob i o2 e mlmlw

[ Untitled 1% (3

TTITr TTITT FTIYTrT T Ty FTrTrTT LA TLTLr LT LTI LT
FIiTaTelilels W WL L g L LT RU TR TR TRTRTRTRIRTRT g b

H]II|I'I|I'I|III’I|HI|I|I|I|ITIZl

wl
54 32 10 1 2 '3 45 & 7 '8 '3 101w

|

v
>

sl
l‘pa

o RC S St A C S JRr A Sl R

Zoom: 60% Cursor: -145.4mm x 132.0mm Hoop: 300mm x 300mm

180.9mm x 162.5mm

Stikches:19218_Nds/Cols: 14/27

Individually selected designs can have a basting stitch added automatically.
This is useful when you want to add a layer of stabilizer or some other material
before the sewing of a design. The baste is always placed intelligently so that it
runs immediately before the selected element(s), as shown in the screen shots

Various elements selected individually and together before applying baste.
Notice where the baste stitches are placed in the Objects View.
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Basting stitches can also be used to secure a layer of topping stabilizer in place before any designs are
sewn. A typical use of this is to add a layer of water-soluble topping to a towel, which keeps the stitches
from becoming embedded in the terry cloth loops during sewing. It can be hard to hoop a towel, and the
topping stabilizer will want to slide around before the stitching happens, so basting it first can make the
process easier.

The basting stitches are added to the start of the design or file, and are added as a separate color; nat-

M Embrilliance - Untitled 1 *

N o o
" inch 1ﬁW

Fle Edt Utity View Zoom Window Help

e BB
0.0° LIRS

[ Untitled 1% (3

TTITITITT
Tt

TTITr 1 TTrTy TTrTrTT TLTLT TETLr LT LTI LT
I el Lol W L L L LR LT R TR TRTRTRTRTRTRT g b T

s 6 7 8 3 10

'y

o1 2 3

2

3

|IH|v‘l|III]IIIITHITIIIIIIIIIJ

T
“

13

<

v
>

Zoom: 60% Cursor: -101,6mm x 110.9mm

R 2 G S e SR L G Jat A G

Hoop: 300mm x 300mm 180,59 x 162.5mm

Stitches:19339_Nds/Cols: 14/27

Here an initial baste is applied and then various areas.

urally you can use any color you want to sew the basting stitches.
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PRINTING

A design template showing the design at full size and with registration marks can be printed. Just
choose print from the File menu.

Print 23]
- Printer
Name: sdobe PDF - Properties...

Status:  Ready
Type: Adobe PDF Converter
Where: My Documents

Comment: ™ Print to file
Print range - 1 Copies |
@ Al Number of copies: m
" Pages hom:h—— !o:[— =

oK I Cancel I

The template can be previewed before sending the output to the printer. Below is a sample template
with a monogram surrounded by a frame. Note the registration marks.

The second page of the worksheet displays size, stitch and color counts, and a list of the colors used in
the design with approximate thread requirements.
12.53 cm x 4.02 cm : 4180 Stitches, 4 Colors

Color 1: Brother Embroidery Applique Pos.
D 61 stitches, 1.0 meters

59 stitches, 1.0 meters
Color 3: Madeira Poly 1710
s 2779 stitches, 9.6 meters

~ Color 4: Madeira Poly 1637
W 1281 stitches, 4.5 meters

D Color 2: Brother Embroidery Applique Mat.

Program Preferences

(Z1 Environment

(] Conversion
@ Files IV Print Color Sequence

IV Print with a realistic rendering {won't show jumps.)

Printing

F R Print Setup

(C3 Adjustments

OK I Cancel I

Printing preferences, found in the Program Preferences window.
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HELP

Getting help for Embrilliance products is just a few clicks away!
http://www.Embrilliance.com

ALPHATRICKS (OPTIONAL)

There are many great fonts in the world, and lots of design companies are digitizing fonts as regular stitch
files. The difficulty with these comes in using them: The letters have to be imported one at a time, there is no base-
line, the sewing order can be messed up if you copy and paste; sizing and color sorting are issues to be managed
too! Plus it would be nice to use the envelopes and text path tools that are used for the built-in keyboard lettering
fonts.

For this reason, we have created the AlphaTricks feature pack! This window is brought up from the Utility
menu item, “Import Font...” and it lets you import fonts as well as manage ones you've already imported. Let’s take
alook at this Import Font dialog box as it contains the mapping shortcuts as well as other useful information and
tools. The following numbered picture is shows you the tools and buttons in groups as they will be described be-
low:

’
B Import Font ﬁ
Font: |[BoldAndCursive o 40 Letter Space (%): |10 : New Font... |
Mame: |30IdAr‘dCursre Word Space (%): Save Font

JLetter [T wmaw: CenterJ vap: AZ | az | mazz| 09 Add[)estqns| Delete Font._|

[T *

1. This shows you the name of the folder that you have selected. Below this is name of the font as it
will be shown in the font list in your program. You may change the font name and this information
will be saved with it and displayed in your font list.

2. We have set the default spacing between letters and words which will be perfectly fine for most
fonts that you map. If you find that these settings need adjusting, you may do so here and these
values will be saved with your font.

3. Here we have the buttons for adding a New font, Saving you mapped font, Deleting a font you have
previously mapped and Add Designs to an existing mapped font.

4. The trashcan button allows you to remove the current letter from the mapping process. The Let-
ter: shows you the name of the current design - once it has been mapped, this field will show you
the character on the keyboard that corresponds to the currently viewed letter.

5. The MGM pulldown is for mapping monogram alphabets - is the current letter a Left, Center, or
Right monogram letter.

6. The Map: buttons are “quick mapping” tools that you can use for fonts that have been named se-
quentially and are displayed as such in this dialog.

Let’s get started. Click the button ‘New Font...” This brings up the window which allows you to browse and
import design files. Since you are importing a whole font, find the folder with the font and click ‘Sel. All’ to select all
the designs. If your folder contains designs that are not specifically part of the font itself, you might want to use the
ctrl-click to de-select those files.
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' Open Design Files . |
== o0
7 T o

Size 3D Close _ Sel, All _Import
Bmwszl

My Font 01 - =

My Font 02
My Font03
My Font 04
My Font 05
My Font 06
My Font 07 Lpes *pes (:pes
My Font 08
My Font 09
My Font 10
My Font 11
My Font12
My Font13
My Font14
My Font15
My Font 16 ).pes 0.pes Lpes
My Font17

= 9 9 4
L A A =
LZ Do its\Desi My Fi BoldAndCursive\l.pes Size: 12.80 x18.20(mm), St: 164, Col: 1 )|
It is important that all the files for the font are together in one folder for easier and complete mapping. If

you discover that some files are missing, for instance the “0”-“9” designs, you can open this font at a later time,
choose Add Designs and resave your font.

Mapping Letters

Once you have the designs loaded into the window, you will have to map them to keystrokes. The field
marked “Letter:” lets you type a character on your keyboard which will map to the current design. The current de-
sign is boxed in by black lines in the view on the right. In the picture at the start of this section, the number 2’ is
selected.

5 Import Font [
Font: |[BoldAndCursive = Leturspxe(%}:llo :" New Font... |
Name: |BoldAndCurs'\-'e Word Space (%): | 15 j Save Font
@I tetter: [ MoM:[Center =] Map: AZ | az Aa-hl 09 Add Designs | Delete Font._|
”

T | 0

If you have a set of designs where all the letters or numbers line up next to each other, you have some
shortcuts provided for you to map the keyboard to the designs. You'll see the buttons “A-Z”, “a-z” and “0-9.” As an
example, click on the design that is the letter “A” to select it. Then click the “A-Z” button. This will automatically
map the A-Z letters to those 26 designs.

If your designs are organized in some other order then you will have to manually type those keys to map
the font.

Adjusting Baseline

Sometimes individual letters require adjustments for their baseline. In
the view, the pictures of each letter are shown, with a black line representing
the baseline. You can click on a letter to select it, and once selected, drag the
letter up or down as necessary to place it relative to the baseline as you like.

«__n “«_.n

Some things like apostrophes always need adjustment, naturally, but letters with descenders like “g” or “y
will usually need adjustment also.
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Spacing

The spacing of letters between each letter and each word can be set using these boxes. The spacing is al-

ways a percentage of the font height.
Letter Space (%): I 10 ill

Word Space (%): | 15 j

Editing Fonts Already Imported

|
# ° Import Font S5
Font: [Bold And Cursive =] teterspxe(n:[0 = News Fant..
. [ADasyDayAphabet PES =
N T —— | Wordsoce 0 [ ] Save Font
> Chrome CESD
W | L{EL 1n Curly fort az | AaZz| 09 | AddDesgns| | Deleteront |

Embroidery Network Swirl Saript PES BW
FSF Boo Font Pes LV

FSF Free Stack Smal ART

FSF Not So Girly Whirly Font ART

FSF Turkey Mono 4x4 ART

Rosewater

______ Upsy Large

Upsy Medium

Upsy Small

Windstar Embroidery Rosewater

i1 |

Use the Font box to select a font that you want to edit. Once the font loads, you can make adjustments to the
font, such as remapping letters, adjusting sizes or positions on baseline, etc. When you have the font how you want
it, click “Save Font.”

If your font is missing letters that you have now located, use the Add Designs button to open the Import
dialog box to select and add the missing letters. You will need to map these new letters and save the font.

Note: Fonts must be named uniquely. If you accidentally name a font the same as an existing on, it will get a
(2) added to the name.

Another Note: Long font names may run past the visible space on the font selection in the Letter proper-
ties, so we recommend shortening the font names using initials or abbreviations. Do this in the Name line under
the Font list box.

Using Imported Fonts

Properties

Coor  Leter | i | When you create a lettering design, you can now use the font that you've im-
=—l0ol ported. Imported fonts are indicated with a needle overlaid on their icon, as seen on

. ™ the picture to the left. These fonts can do almost everything that the built in fonts can

do, such as make monograms, circles and even be shaped. When these letters get

| ABC s -z sized, the built-in sizing technology will recalculate their stitches.

. ABC  wox G

_ There are however, no stitch properties for these fonts, as they are stitch-files, not our

“‘/g‘gg, :'::;:;D | digitized objects. So removing of hidden stitches, underlay and density cannot be

ABC coney changed, for example.
| ABE ey

H ﬁ)Bé Embroidery Network Swirl Script PES BW
| ABE, rsroooFonteesty
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Density Repair Kit (Optional)

DENSITY REPAIR KIT (OPTIONAL)

Welcome to The Density Repair Kit, the most sophisticated density adjustment and analysis tool
available for the embroiderer!

DRK does the following:

* Removes hidden stitches from within a design so that it will sew thinner, cleaner, and with less
thread (and needle) breakage.

» De-Clumps design areas. These are areas that are over-sewn repeatedly with the same color.

» Filters small stitches from your designs that would otherwise create thread build-ups and jam
the machine.

» Reduce the density in designs that were shrunk to fit a hoop.

« Increase the density of designs for better coverage.

 View the density of designs to see how they’ll sew before expending time and thread on a trial.

« Limits the density of your designs based on the fabric and thread that you are using.

« Informs you of how best to embroider the project or fabric that you are working on. It recom-
mends stabilization, hooping technique, needle type and size, and thread weight to help your project suc-
ceed.

« Saves you time and money. Reduced stitch counts save enormous amounts of time and thread
usage. Proper density adjustments allow projects to complete successfully. With DRK, project time and
thread savings of 15%-30% are common!

Why The Density Repair Kit?

Have you ever had a design come out bad? Of course, we all have. That's why DRK was created.
DRK cleans up embroidery designs that are too dense or poorly digitized for your project.

How? Like its name implies, DRK has a set of tools to adjust the density of embroidery designs.
These tools help you embroider with greater ease. You can alter the density of any design, and make that
design work on virtually any project or fabric type.

It does this by asking you what you are going to be sewing on, and then it analyzes the density of
your embroidery design and adjusts it.

Now, you're probably wondering if it takes an embroidery instructor camped out a week at your
house to get you up and running. No, it doesn’t. You can have the program do everything automatically or
you can control it manually. Running DRK is easy.

A Side Effect of DRK

By reducing the number of stitches that are in a design, DRK saves you an incredible amount of
time. Even with today’s fast-stitching machines, 10,000 stitches is still around ten minutes. The thread
savings, the number of bobbins saved, and the frustration of failed embroidery all add up! Imagine tack-
ling a project and knowing that it will sew okay before you even start!

If you're intrigued please read on.

The Density Map

The Density Map is a graphical display of the density, or stitches-per-inch in your designs. To see
m the Density Map, click the button on the main toolbar. This is useful to see if a design is not going
to sew well. For instance, this is a design that has been overlapped, thus its density is very high.
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Where the design shows bright red in color, there are six layers or more of thread, which undoubtedly
will produce poor embroidery results.

The Density Map can be used to illustrate when a design (probably from the internet) is dangerous
to sew on a project without test sewing it first. And it also helps identify when you would want to you're
the Remove Hidden Stitches function or even the Sweep. Those features will remove stitches that are
likely to cause poor design production, while maintaining the same visual design. Here is the same design
after a Sweep is performed:
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Wireline View

The WireLine Density Map is like a x-ray of your design, allowing you to see through the layers of stitch-
ing to analyze those under- neath. It helps to see the relationship of padding stitches, as well as how a de-
sign has been compensated. You can view the whole design or individual colors to better see what’s going
on inside your design. Zooming in the WireLine allows you to get up-close and personal with the stitches
to see how they were digitized. When determining which colors to remove hidden stitches from, the
Wire- Line Density map is your best analysis tool. And, in addition to all the above, it looks really cool.

Stitch Properties

The DRK version of Embrilliance allows for more control of the stitches using our Project system.
The Stitches property tab adds controls to use the project settings from the Project Advisor to remove
stitching, De-Clump, and limit the density.

Properties

Color  Stitches

Density adjustment:

Satin: 0%

Fill: 0%

| Prevent Sweep
Filters:

| Use Automatic Settings

| Limit Density (Based on Project)
| De-Clump

| Remove Underlap (intra-design)
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Density Tuning
DRK has a density tuning control that lets you adjust the stitch

count of your file while keeping it the same size. As the program ad-
justs the stitches it will also keep the pattern fills intact.
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By moving the density tuning control slide + or - 25% you can

easily adjust the density.
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density according to the new size of the design.
Another use for the density tuning is to increase the coverage

that a design gives. For instance, using puffy foam under an area of

satin stitches in a design that wasn'’t originally intended for it can

now be accomplished by increasing the satin fill density for that col- -
or. Or if you are embroidering a towel, and want better coverage to :
keep the loops in the terry cloth from popping through, simply in-

crease the Density Tuning slider.

After reducing a design to fit your hoop, DRK can alter the =

TR
TLRTY i o

Filters
e Use Automatic Settings: makes use of the Project Advisor project to identify the fabric den-
sity, thickness, stretch and material being used. The needle penetrations are then adjusted

accordingly.
e Limit Density: Certain combinations of fabric and stabilizer have limits on the number of
stitches per square millimeter. More than that causes poor stitching or puckered fabric. Us-
ing the Project Advisor, the limiter will reduce the stitch counts in the affected regions.

Remove Underlap (intra-design): Often a design has color layers that have some overlap for

[ ]
the purposes of registration. However, many times these regions are a result of auto-
digitizing and poor results follow. The so-called, “Bulletproof Embroidery,” is an example.

When stitching enters an area within a design that will be covered by a later color, those
stitches can often be removed, and that is what this does.
De-Clump: Within sewing a single color, areas sometimes get too many stitches overlapping

[ ]
in small groups. These areas form clumps of thread on the back of the fabric which can be-
come entrapped in the needle plate. Sometimes this traps the embroidery in one place and

cause loss of registration. De-Clump reduces these stitches.

Limit Density
Some designs are simply digitized too dense for certain projects. Other designs work well except
for particular areas in the design that are too dense. When you select a fabric density and thread weight
in the control group “Automatic Density Adjustments,” the Density Limiter creates a minimum-allowable
density for your project. The Density Limiter will analyze each section of your design, looking for stitches
that are too close together. It will then selectively adjust the density of those areas that need it. Only areas
that are too dense for the project and/ or thread are affected. This filter is very helpful when you in-
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crease the thread weight. Fabric stabilization needs to be radically increased with heavy thread. By re-
ducing the number of stitches, heavy threads can be better supported with less stabilization. Also, this
filter will help preserve a clean look to your designs when working on loose fabric. Because the fibers in
the fabric are farther apart, stitches will tend to clump in one needle-hole, rather than fanning out evenly.
This gives a ‘pinched’ look to the edges of the embroidery. If your design is too dense for some fabrics,
your needle can actually cut the fabric, leaving you with a hole and a patch instead of embroidery.

Remove Underlap

Now you can combine designs and have them overlap! In the past you could not do this because
the area where they overlap would have too many stitches. This tool can automatically find those over-
lapped areas and cut out the stitching underneath so that the design can sew flat!

Here’s a great example for the use of this tool:

Suppose that you want to create a drop-shadow for text. Duplicate your text, and change the color.
Then position the top color slightly up and to the left. Remove Hidden Stitches to flatten the result so that
it will look nice and sew easily.

What about areas that were digitized without ‘hole-sewing’ mode turned on?

Say an area of color has another color sewn in the middle of it. Remove Hidden Stitches will ‘flat-
ten’ the area under the second color by converting the hidden area to a satin fill. This makes it less diffi-
cult for the needle to penetrate the fabric as the top color is sewn.

In some designs more than one color is used to create padding stitches for the entire design. In
this case you will want to turn the “Keep Padding Stitches” feature on in the Preferences Window. These
stitches are technically hidden and will be removed otherwise.

Maybe you want to do this. But the first eagle’s wing is a problem:

The under wing needs to be removed. Select Remove Hidden Stitches to remove the under wing of
the eagle:
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Your design is ready to sew. (And it will!)

Note: This is different from removing hidden stitches created by overlapping separate designs, such
as in a composition. This filter works within a single design.

De-Clump

This is a variation on the Remove Hidden Stitches filter. De-Clump will analyze a color and remove
stitches that are hidden within that single color.

When a color sews repeatedly over itself, it can create a thread build-up that prevents the design from
sewing nicely. Too much thread will distort a design, causing the fabric to ripple around the edge of the
design. De-Clump helps to thin the design by reducing the number of thread layers.

We're certain that you’'ve watched a design sew in-place a dangerously long time. If you're like us, you
hate watching it because you just know it’s going to jam up. De- Clumping takes the worry out.

Another benefit from De-Clumping is that you can get rid of excessive padding stitches from poorly
digitized designs, as well as those annoying sections where a design sews over itself. HINT: A topping,
such as a water-soluble stabilizer, provides most of the support your design needs. This can help in situa-
tions where the padding was poorly implemented. NOTE: Designs that have padding stitches removed by
the De-Clump filter will sew out differently. You will encounter more jump stitches nested in the design.

It is ok to cut away the jump stitches while sewing. If you prefer, however, you do not have to since all
these stitches will be sewn over later.
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The Sweep

The Sweep function, which is run from the button with the vacuum on it, will remove
hidden and nested stitches within designs, as well as removing hidden stitches where designs
' are overlapped.

These patented filters operate on the colors of a design to help reduce the stitch count,
removing excessive overlays and stitches that tend to ‘ball up’ on the underside of the fabric.

Removing hidden stitches occurs as the program examines the design, looking for color layers that
overlap more than is necessary for compensation. If stitches of one color layer are on top of the stitches
for another color, and those stitches are not visible, they can usually be removed. Stitches that would be
overlapped at the edges of the colors are important for the design so as not to have gaps, thus they are
not removed. What you get is a reduction is stitch counts, a reduction in sewing time and a reduction in
puckering.

Note that the Sweep is different from the process that removes stitches from overlapping designs.
The Sweep operates within a single design, whereas overlapped designs are ones that are merged in sep-
arately and then laid on top of each other. The processes are similar, but different in that way. Another
difference is that the Sweep filters are not temporary; they are re-run on the designs as they are adjusted
(for instance by sizing.)

De-Clumping is a process where stitches within a single color are eliminated if they will gather up
in small areas. These clumps of stitches can often prevent the hoop from moving freely by forming a ball
under the fabric which can anchor the needle in one area. When and if the hoop finally pulls away, the us-
er often hears a ‘clunk’ sound and their project will probably have a gap, as registration may have been
lost.

N__»

Occasionally one of the sweep filters will leave an undesirable result, which is visually evident. As
arule, these filters do a great job, and if the design looks good on the screen, it will sew nicely. However, if
you see something onscreen that you don’t like, you can prevent the Sweep from running on individual
colors using the Stitch Properties tab.

Note: You can also prevent Sweep operations for occurring on certain objects or designs when you
want to.
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Project Setting

Project Advisor

Flease select a project/fabric type:  Recommendations: i~ StitchPerfect: No current setting
|L| Needle: Leather, size 14 Set Project No Project ‘
Thread: 30 wt.

You may also modify the settings:

When you have chosen a project, the program lets you set that project on the design page so that
the Stitch Perfect filters can use it.

If you would like to clear your project, you can click on ‘No Project.’
The Project system stores information such as Fabric, density, stretch and stabilizer to help the fil-

ters for stitch files minimize the pucker and gather that occurs when designs are used on lighter fabrics
than for which they were digitized.

Where DRK Gets Fooled

Remember that it’s just a program running on a computer, and that's the same type of system your
bank uses to lose your credit card payment. Computers don’t know anything about you or what you are
doing. They are only taught to handle basic general parameters. We’ve tried to make the automated tools
work well for most designs, but please look at the result before sewing. This will save you a lot of time.

Here’s a for-instance: Cross-stitch designs sew over themselves a lot. De-Clump sees this as a no-
no and tries to lighten the load. This will result in extra jump stitches, and you’ll be mad at us. We haven'’t
figured out how to teach the computer to know that you are doing cross- stitch yet, so you’ll have to keep
that in mind. A little common sense (yes that can be an uncommon thing) will help a lot. Overall though,
we think you’ll be amazed and happy and dance.
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ENTHUSIAST (OPTIONAL)

Once you have mastered the Essentials, you might be ready to play a little bit more, explore more
advanced functions, and take on a little more challenge. If this is you, you might be an enthusiast. We
named this program after you!

e Stitch editing

You can select stitches in your design using Lasso and similar tools; move, delete, copy paste, split,
and more. Repair gaps in stitching. Adjust compensation, change stitch type from satins and fills, select
and correct stitch types, including cleaning up jumps, ensure tie stitches before and after jumps.

e Multiple hooping

Many built-in multiple position hoops pre-loaded. Split AUTOMATICALLY using our patented fea-

ture. Use Mega Hoop, Plus Hoop, Jumbo Hoop, Dream Hoop, etc.
e Baste Hoop

Beyond basting a design, sometimes tricky fabrics and toppings require an extra bit of help.
e Precise Position

Accurate positioning of any design on the page. Use this advanced customizing feature for perfect
layouts.

e MirrorX4
Take corner designs and perfectly set them in all four corners of the hoop.
Instant repeat
Repeat a design across and down. Make a nice effect.
Carousel
Create a circular composition out of your designs.
Scatter
Unique effect to create copies of your designs, including lettering, for neat effects on large spaces.
Advanced Thread editor
Beyond the Essentials palette creator, the Enthusiast editor lets you make your own thread
brands, and pick colors right off web pages or PDFs.
e Advanced Sizing controls
The sizing in Essentials is automatic and very clever, but it uses a set of default parameters. The En-
thusiast in you might want to adjust those parameters.
e Advanced Stitch properties
Control satin and fill density within each color layer in any stitch file.

Stitch Editing

The ability to edit individual stitches is a very useful tool. Sometimes there are parts of a
_CE design that you simply do not want. Other times, there are jams of stitches that simply cannot be
removed any other way. In still other cases, you want to add a few stitches to get rid of gaps or
increase coverage in an area that’s not necessarily a fill. Maybe you just want to make a pocket topper?
To begin editing a design’s stitches, click the Stitch Edit button on the toolbar. This will cause the
Tool pane to display the Stitch Edit controls, and the main view will show the stitch points.
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Stitch points can be turned on or off from the View menu. They help identify the individual needle

penetrations in the design.
Selecting Stitches
Stitch selection is accomplished two ways:

1.) Arange of continuous stitches.
2.) A graphical section of stitches (lasso, rectangle, brush selection).

You can select a range of stitches by clicking an ‘Anchor’ stitch, and then use the keyboard to select

additional stitches. (See the keyboard reference at the end of this section.)
Here you can see that we'’ve selected a range of stitches inside the

oowv‘,gwm'“'“"“?l;;; """""""" golf ball, but we’ve skipped the satin stitches that go around the edge. If
we hit delete on the keyboard, we can remove them!
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Another way to select stitches is graphically. You can drag a rectangle or a lasso around stitches to

select them. You can also use the Brush selection, which selects anything the cursor touches, or with the
Ctrl key, the brush can de-select points. Selected stitches can be deleted with the ‘delete’ key or split using

the ‘Split’ button.
You can also select stitches for an entire object or design using the Object View. While in Stitch Ed-

it mode, simply select objects in the tree and the corresponding stitches will be selected.
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Right: Selected

Lefé Lasso.

You can also select a single stitch by clicking on the line representing the stitch itself. Make sure no
other stitches are selected first, and then simply click on a stitch line. The stitch point at the end of that
line will select. This makes it easier to select a single stitch out of a jumble of stitches that may exist near
each other.

Converting Stitch Types

You can right-click to bring up a context menu which will give you the ability to switch stitch types
between Jump and Normal stitching. For color stop inserting, use the Sewing simulator.

When you convert a stitch to a Jump, you have the option of ensuring the stitches on either side
are tied off. If you choose this option and the stitches are already tied off, then no stitches will be inserted.
Ensuring Ties

If you have a stitch that appears not to be ties down, and you will want to cut it, you can ensure
ties using the context menu. Simply select the stitch (as directed above) and then right-click for the con-
text menu.

Splitting a design

Once stitches have been selected, you can delete them or split them, To split them, click
':é i:':' the ‘Split’ button. This will create a separate design for the selected stitches. It will also remove
the stitches from the current design. If your design is lettering or a Library design, this process
will convert that design to stitches so you will not be able to adjust that design the same as before.
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Above, the design has been split, and the crown was copied and pasted.

Insert Stitches

If you have a stitch selected, you can right-click to get a pop-up menu which will let you insert
stitches.

Notice that you can see the direction of the stitches when you are zoomed in. This helps determine
‘before’ or ‘after’. The arrow on each stitch points toward the next stitch as the design would sew.
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o s

Insert Before
Insert after
Delete

Left: Right-click to select the Insert mode.
Middle: Inserting stitches.
Right: Stitches have been inserted.

Converting Stitches

Using the ‘Satin’ Drop-down box, you can convert selected stitches to a satin stitch, a choice of split
satin stitches, or even add a fill effect to an existing satin stitch.

Adding compensation
Once stitches have been selected, you can add compensation, which makes the outside stitches of
fills or satins a bit longer or shorter. This is useful when you have gaps in a stitch-out and you would like

to ‘stretch’ the stitches together, thus reducing or eliminating the gaps. You can also use compensation to
adjust the width of lettering you may have imported.

eft: a tyicly gapped design. Middle: The stitches around the gp are selectd. Right: Compensa-
tion has been added by moving the slider to the right.
Keyboard Shortcuts

Left Arrow: Select Backwards

Right Arrow: Select Forward

Up Arrow:  Select Forwards 10 stitches
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Down Arrow: Select Backwards 10 stitches

Page Up: Select next command (jump or color)
Page Down: Select previous command

Home: Select First stitch

End: Select last Stitch

Delete: Delete selected stitches

Shift Left Arrow: Range select backwards
Shift Right Arrow:  Range select forward

Shift Up Arrow: Range select forwards 10 stitches

Shift Down Arrow: Range select backwards 10 stitches

Shift Page Up: Range select next command (jump or color)
Shift Page Down: Range select to previous command

Shift Home: Range select to first stitch

Shift End: Range select to last Stitch

Multi-Position Hooping

SO, YOU SAW IT ON THE INTERNET AND HAD TO HAVE IT.
BUT IT’S TOO BIG FOR YOUR MACHINE...

Embrilliance Enthusiast has our patented design splitting technology built into it. This system au-
tomatically splits designs into multiple positions for sewing as separate designs which tile together to
make a larger design. In the past, splitting a design took hours of editing by a person schooled in the pro-
cess.

Our splitting drastically reduces the visible ‘seams’ that occur from manually splitting files using
an editor. In most cases, the final product is indistinguishable from one created on a larger-field machine.

Some hoops have multiple positions. This means that you only hoop the fabric once and generate
the design by sewing it in those multiple sections. However, you can achieve the same result by re-
hooping the fabric multiple times to create the design. We call this a “Virtual Hoop.” The Essentials ver-
sion of the program comes with many hoops and virtual hoops pre-defined. The Enthusiast version has
creation and editing of these hoops as well.

When sewing designs in multiple sections, often the question of alignment comes up. This is ac-
complished automatically with multi-position hoops, but to make it easier for regular hoops, the program
will add basting stitches which will align the designs. To choose a hoop, click the preferences button on
the toolbar, and the Hoops window will appear:

Program Preferences ﬂ
=4 Environment
% Hoops PES =] [ Hoop Style:
Grid Settings Tombo Frame 14" % 12" " Nomal f* Multi-Postion
Calibrate Screen :I%Ex ?Eg f;”"bDHHDDP
x 172 Large Hoop
Mouse Wheel Blageo x 2
Check for Updates Begante x 2
Ellisimao x 2
ghD:t .Mode Embroidery Professional x 2 IzEe
Igitizing Hoop-it-All 300500
23 Conversion Hoop-it-All 300400 I Rotate 50
3 Files Hoop-1t-All 300300
Defaults
(23 Printing 4

Adiust t Sewing Field: The design centers are offset from each other:
(1 Adjustments Width- 350 mm. 18.00 cm. Up and Down.
Height: 350 mm.
oK | Cancel

69



Embrilliance

The Multi-Position hoops are separated from the Normal hoops, and you click on the Hoop Style to
select which list you want to see. Here is the Jumbo Frame:
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Sewing

You'll notice that this hoop has two rectangles, which overlap in the middle. Each of these repre-
sents a sewing field. To make it more obvious which lines represent which field, the inside of each rec-
tangle has a dotted line indicating the inside of the field.

If you are combining designs to make a composition, it is always going to give the best result if you
keep whole designs into one region. This produces a split which will have the least effect on the actual
stitches on the design. Of course, this is not necessary, however, as the design may be split even if it lies in
the middle of the hoop, but some splitting would have to occur.

The ‘+’ marks shown indicate the centers of the sewing fields.

Note: If you look at the Hoop in the selection window you will see a note that the design centers
are offset from each other. This means that when you sew the two sections, the centers of each design
will be separated by that amount. This is your initial placement method for each design.

The design centers are offset From each other;
10.00 cm. Left to Right,

In order to position your design, it is always advisable to print an actual template of the design.
This helps you visualize what it will look like once embroidered, and it will help define the center position
of the design on the fabric. Once you have the center of the overall design, then you will want to mark the
centers for the individual fields. In the example above, this would mean that you mark the fabric 5 cm.
from the center on both the left and right of the design center. This places the two designs 10 cm. apart.
This basic positioning will help you get the result onto the fabric where you want it to go.
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You can split the design using the “Split Into Hoop” from the Utility menu. This will open a new de-
sign page with the split files so that you can preview them or do other work before saving.
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Left: A single design placed on a 100x172 hoop.
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Color | sttches |
Thread... | 1 Color... | Prefenred
Clck below to change individusl colors.
1: Lime Green ~

2 Leal Green

3 Deep Green

4 vhite
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6 Desp Rose

7. Amber Red
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Click below to change individual colors.
1: Lime Green

2 Leat Green

3 Deep Green
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Right: The design has been

In the example above, the 100 x 172 PES hoop was chosen, and the design was centered in it. Then
the menu item, Utility->Split Into Hoop was chosen. This created a new design page, represented by a

new tab. In that page there are two designs, one for the top hoop section, and one for the bottom. Using
ghost mode, we show the designs separately:
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Theeod... | 1cCobr.. | Prefered f Theead... | 1 Cokr.., | Prefemed |
Click behow to change individual colors. ' Click below to change individual colors,
1: Lime Green - [} 1: Lme Green -
2 Leal Green ” 2 Leaf Green
2
3 DeeplGiean - 3 Desp Green
4 Lemon Yelow 4 Whis
T |5 CenYebn R e W e 5 Pirk
& Havest Gold 6: Deep Rose
[ 7 ZiAnbeiRed. ¥

Left: The top design is selected.

Right: The bottom design is selected.

When you save this page, multiple stitch files will be created, as described in the next section,

“Output Files.”
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Output Files

When you save your files, the output files represent each region of your design.

The files are automatically given names indicating their stitching order as well as the position
within the hoop. For instance, “Rose.Pes” may split into “Rose Top #1.Pes” and “Rose Bottom #2.Pes”.

Additionally, you may get a text file that explains the color sequence for your new files. In many
designs, a color is only needed in one region. Where this is the case, that color will not exist in all the out-
put files. To help reduce this “Color Confusion”, a text file is created with a table. The following is text
from an example file:

“Roses.Pes

Your original file had 3 colors.

The program has split your file into 2 segments.

This cross-reference has been created for you because some thread colors in the original file were
not needed in some of the split segments.

File: C:\Roses Top #1.PES

Color 1 = original color 1

Color 2 = original color 2

Color 3 = original color 3

Color 4 = original color 4

Color 5 = original color 5

File: C:\Roses Bottom #2.PES

Color 1 = original color 1

Color 2 = original color 2

Color 3 = original color 3

Happy Embroidering!”

As you can see, the table is easy to follow. Since this is a text file, you can view it in Designer’s Gal-
lery Studio. You can also edit it (double-click to launch Notepad), print it, etc. It is a good idea to add any
real thread numbers or names if you have them. Often, the digitizer of a design will supply a real-color
thread list for this purpose.

We cannot stress enough the fact that the order of embroidering the files is important.

The files will overlap each other as they sew. If you embroider out-of-order you will get overlap-
ping that is incorrect, and parts of your design will not be visible!

Region Naming:

On hoops that have three positions, the regions are named for you: Top, Center and Bottom. On
hoops that have more positions, the other positions are given numbers, starting at the top. Hence, you
might have a hoop with: Top, Pos. 2, Center, Pos. 4 and Bottom. Columns have names like “Left”, “Right”
or “C2”.

Getting Results

To get the best results, there are some things you should know.
First is that you should trim your jump stitches as you go, if your machine does not do it automati-
cally. This is true in the course of normal embroidery, but somewhat necessary when embroidering a
split design. When splitting a design, it is natural that the machine will have to go from place to place a
little more frequently. This results in extra jump stitches. We have made every effort to minimize the
amount of effort that it takes to split embroidery files, and apologize for any inconvenience this may
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cause, but please accept our assurance that your finished product will have a nicer appearance if you
clean the jumps from the design.

If you are using an appliqué design, you will need to embroider each color in each region before
moving on to the next color. This will ensure that the full appliqué can be applied without incorrect over-
sewing by the other colors.

There is a compensation control in the Hoop Properties window. This control is available on all
hoops, even the factory-defined ones. Compensation is the amount that each region will overlap the
neighboring regions. This is used to correct for the fact that fabric will shrink as it is embroidered. Addi-
tionally, an imperfectly hooped project will allow registration problems to occur. If you are not able to
hoop your fabric, ‘Drum-tight’, then you may want to increase the compensation setting for your hoop.

Important: If you are increasing the size of a design, please don’t increase the size more than you
will actually need for your hoop.

Note: There is a very important phrase in the computer industry: “Garbage in, garbage out.

Precise Position

You can precisely position designs using these buttons. The three buttons on the (top, left) control
the display of the x-axis position. There are Left, Center and Right, which means that when you have the
Left button set, the display will be of the left edge of the design.

e[ [T
o alfore

Similarly, the bottom three buttons control the vertical axis, top, center and bottom respectively.
The position controls are very useful for creating tiled patterns.

Your best friends will be the top ruler and left ruler along the edge of the Design Page. You will no-
tice that center of the ruler is “0”. To the left of “0” is -. To the right of “0” is plus. Let’s place a design on
the design page and get started with Precise Position!

1. Decide what size embroidery hoop you are going to use and open it onto the Design Page. You will
notice that there are four quadrants inside the hoop.

2. Open a design onto the design page.

3. Place the design in the top left quadrant. Note the numbers in the x and y location boxes. (-47.17
and 50.25)
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4. Select the design and right click to copy and then right click to Paste the design.

5. Click on Flip Horizontally .

6. Delete the “-“ from 47.53 and hit enter. This will move the copied design to the right top corner.
7. Select the design and rigt click to copy and then right click to Paste the design.

8. Click on Flip Vertically.

9. Place a “-“ next to 50.14 in the y location box. (-50.14)

10. Hit enter The de51gn moves to the bottom rlght corner.

deryWorks - heariper
e e Unity View Zoom Window Help

[ s cooulmassd t0Is A
@um |*a[5380  [100.0% i) L =
= f;—ﬂ —#’ :ﬂ?ﬁ JJ fjr—r,

4 he .« -uu ﬁ s
4 Praperte 2@
N Color | Setches |
- Thead.. | [TGor_ | Prefenes
2 ik beom 10 change dvidual coors
oy 1 A& Rayen
- 2881
3
e
e
Zoom: 100% Cursor: 140 2mm x 435mm = Seiected 93mm y90mm  Sttches 1134 Nah/Cols 111

11. Copy and paste the de51gn in bottom right corner.
12. Click on Flip Horizontally.
13. Place a “-“next to 47.53 (-47. 53) in the x location box. Hit Enter.
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14. Your frame is now complete!
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This is a great way to align your designs without the frustration of where you placed the first de-
sign and how to get the others to follow suit.
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Instant Repeat

From the Utility menu, select “Instant Repeat.” This will call up a window that lets you create a
pattern of designs, copied from the current selection, and pasted in rows and columns.

To change the values, you can click the arrows next to each value, or type in a value and then click on an-
other one to set it.

As you change the values, you will see your result on the main view.

Click OK to accept your new designs.
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Above: An example of a repeated design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying to fit
an area, for example the hoop.

Note: The initial design will be the (top, left) design, and the copies will go to the right and down.
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Mirror X4

From the Utility menu, select “Mirror X4.” This will call up a window that lets you create a pattern
of designs, copied from the current selection, and pasted in mirrored corners.

To change the values, you can click the arrows next to each value, or type in a value and then click on an-
other one to set it.

As you change the values, you will see your result on the main view.

Click OK to accept your new designs.

Mirror x 4

A

Horiz. gap 55 3: oK. : E
W Vert. gap 7 3: Cancel W El
Angle: [T 3: ; :

X
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Above: An examp}e of a Mirror X4 design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying to fit
an area, for example the hoop.

Note: The initial design will be the (top, left) design, and the copies will go to the right and down.
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Carousel

From the Utility menu, select “Carousel.” This will call up a window that lets you create a pattern
of designs, copied from the current selection, and pasted in an elliptical fashion

To change the values, you can click the arrows next to each value, or type in a value and then click on an-
other one to set it.

As you change the values, you will see your result on the main view.

Click OK to accept your new designs.
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Above: An example of a Carousel design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying to fit
an area, for example the hoop.

Note: The initial design will be the (top, left) design, and the copies will go to the right and around.
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Scatter

From the Utility menu, select “Scatter.” This will call up a window that lets you create a pattern of
designs, copied from the current selection, and pasted in random locations based on your dialog box se-
lections.

To change the values, you can click the arrows next to each value, or type in a value and then click on an-
other one to set it.

As you change the values, you will see your result on the main view. Click on New Pattern to generate a
new random pattern based on the selected values

Click OK to accept your new designs.

Sizes are

Width 180 = oK
Height 130 = Cancel

| [V Auto-rotate
| [v Random Mirror

Min size 50 3:

Max Size 140

Spacing

Above: An example of a Scatter design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying to fit
an area, for example the hoop.

Note: This is a way to get a random repeat of similar designs.
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Creating colors using Enthusiast

The Enthusiast version of the program adds the ability to create your own colors and add them to
thread lines and palettes. To create a new thread or palette, click the ‘New’ button on the toolbar.

Click the ‘Add Color’ button to create a new color entry in the current thread / palette. Type in its
name and thread number, if those exist, then adjust the color itself.

Using the ‘Sheen’ setting, you can alter how the thread will display when 3D rendering is turned
on in the main display. You can also input up to four variegated colors on a thread. Using the ‘Var’ drop-
list (short for variegated) you select the number of colors used. There will appear a set of buttons ‘V1’-
‘V4’ each of which allows you to select and set the color for that particular variegation.

The color grabber tool will let you click in any window and pick up whatever color is under the
cursor. This is very useful when you are building a thread palette from a document such as a .pdf or a
thread manufacturer’s webpage. If you want to adjust the color visually, use the HSV (Hue, Saturation,
Value) sliders until you get a color that you like.
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Left: A typical thread list. Right: A variegated color in a user palette.

Sizing Properties

When you resize a regular stitch file, the density would normally get more or less dense, but Embril-
liance will recalculate the stitches for you automatically.

Program Preferences

(3 Environment
(23 Conversion Sensitivity: 11 _— |7 [V Gap Reduction
[Z1 Files
3 Printing ¥ Min. Length: 0.3 mm [V Max. Length: 7.0 mm
| Adjustments —_J— —J—
% Sizing
IV Min. Sat. Lenath: 0.3 mm [V Max, Sat. Length: 7.0 mm
¥ Min. Fill Length: 0.3 mm IV Max. Fill Length: 7.0 mm

_Ji _J—

OK | Cancel l Apply l

That recalculation process is complex and difficult, so there are some settings you can adjust to
achieve optimal results. The sensitivity control is used to control how well the program discovers fills
and satin stitches. If you have a design which has a lot of manually created stitch effects, then you may
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want the sensitivity higher, whereas normal designs that are digitized with objects like fills probably
don’t need so much sensitivity, especially if there is blending going on.

* Gap Reduction is a function within the software that helps adjacent areas lessen gaps that might be
exposed or widen during increases in size.

» The stitch length filters are used to prevent loopy stitches on the fabric from stitch elongation, and
in the other direction, small stitches from gathering on the fabric making too many perforations or
simply bunching up the fabric.

The settings are broken out by stitch type because the handling of satin stitches is special and you

may want to achieve a split-satin look at a certain size.

Stitch Properties

The stitch properties tab appears when a stitch design is selected. There are controls where you
can add or remove up to 25% of the stitches by increasing or decreasing the density of the selected items.
The slider controls will separately allow the adjustment of satin stitching and fill stitching, which allows

very specific control.
Properties Q|

Color  Stitches ]

Density adjustment:

Satin: 0%

i

Fill: 0%

[ Prevent Sweep

If you are a DRK user, there are additional controls which also tie in to the Project Advisor and the
Project system.
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Baste Hoop

With Essentials, individually selected designs can have a basting stitch added automatically. This
is useful when you want to add a layer of stabilizer or some other material before the sewing of a design.

But with Enthusiast, a basting stitch can be added to the hoop, which allows for a layer of topping
stabilizer to be basted in place before any designs are sewn. A typical use of this is to add a layer of water-
soluble topping to a towel, which will prevent the terry cloth loops from coming up through the embroi-
dery. It can be hard to hoop a towel, and the topping stabilizer will want to slide around before the stitch-
ing happens, so basting it first can make the process easier.

1l TBasting added toithe hoop

The basting stitches are added to the start of the design or file, and are added as a separate color;
naturally you can use any color you want to sew the baste.
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MONOGRAM PLACEMENT GUIDE

Towels

General Instructions: The placement goes on the opposite side of the fabric and at the opposite end
from the label. This allows a traditional triple fold to display the monogram. Folding the towel as you
would display it helps visualizing and marking the correct placement.

Bath Towel: The bottom of the monogram should be 4” above the hem or 1” to 2” above the dobby
border, if present. The monogram should be 4” tall.

Beach Towel: The bottom of the monogram should be 5” above the hem or 2” to 3” above the dobby
border, if present. The monogram should be 5” tall.

Golf Towel: The monogram should be centered horizontally with the top of the monogram .5” below
the grommet. The monogram should be 1” to 2” tall.

Hand Towel: The bottom of the monogram should be 2” above the hem or 1” to 1.5” above the dobby
border, if present. The monogram should be 3” tall.

Sports Towel: The bottom of the monogram should be 1.5” above the hem. The monogram should be
1.5” tall, and may be placed on a 45-degree angle.

Wash Cloth: The bottom of the monogram should be 1.5” above the hem or 1” above the dobby bor-
der, if present. The monogram should be 1.5” tall and may be placed on a 45-degree angle.

Bedding

General Instructions: Don’t annoy your sleeper. Placement and thread can affect the comfort of the
item. Spread out the item as you would see it on a well-made bed to help with visualizing and marking the
correct placement.

Top Sheet: Top Sheets are placed on a bed upside-down and the top (wide hem) is then folded back
to right-side-up. This means that the monogram is apparently embroidered upside down. Looking at a
made-up bed will help you visualize this. Place the bottom of the monogram 2” from the wide hem, cen-
tered. The monogram should be 3” to 4” tall. Embroidering inside the wide hem is sometimes preferred,
and when doing so the design is sized to fit.

Pillowcase: Embroidering inside the wide hem is generally preferred, and when doing so the design
is sized to fit. If the font allows it, the monogram should be 2.5” to 3” tall. Placement is centered, mono-
gram facing toward the opening.

Pillow Sham: Center the design on the sham, facing the long edge as if it were a pillowcase with an
opening. The monogram should be 2.5” to 4” tall.

Blanket: Centered on the top like a sheet or facing into the bottom, right corner at a 45-degree angle.
The monogram should be 4” tall.

Duvet Cover: Centered on the top. The monogram should be large, up to 12” tall.

Home Decor

General Instructions: None. This is all according to taste, fashion and style.

Napkin: Embroider 2” in from point of corner. Distance may need to be increased if there’s a border
or hem. Place opposite of label or tag. The monogram should be 1” to 2” tall.

Placemat: Top-right corner, 3” diagonally from point of corner. The monogram should be 1” to 2” tall.

Table Runner: Embroider matching designs 4” from end. The monogram should be 4” to 5” tall.

Table Cloth: Embroider 4” from corner, with design facing into corner at a 45-degree angle. The
monogram should be 4” to 6” tall.

Garments
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Coat Lining: Embroider on the right side at the waist level, 3” from the seam. Monograms should be
1” to 1.25” tall.

Collar: Embroider on the left side, above buttonhole if present. Monograms should be 3/8” tall.

Golf/Polo Shirt: 7.5” to 9” below the shoulders left seam and 4” to 6” from center. Depending on the
design, you can also look for a line down from where the collar meets the shoulder seam, and look over
from the 2nd buttonhole.

Long Sleeve Shirt: Top and center of wrist, which is about 1” to 1.25” from the center toward the but-
tonhole. The bottom of the monogram should sit very near the top stitching of the cuff. Monograms
should be 3/8” tall.

Robe: Draw a line straight down from the shoulder seam 4” to 6” for women and 7” to 10” for men.
Find the center of the armholes from the armpit to the shoulder, and draw line straight across toward the
center of the robe or go across 3” to 5” from the center.

Shirt Placket: Center the design between 2nd and 3rd buttonholes. The design should be 1/4” to 3/8”
inch tall.

Shirt with no pocket: Draw a line straight down from where the shoulder seam meets the collar
seam. Find the center of the armholes from the armpit to the shoulder, and draw line straight across to-
ward the center of the shirt. The center of the design is marked where the lines intersect. If the armholes
are deep, the line can be made too low on a woman’s shirt, so keep that in mind.

Shirt with pocket: Center the design on the pocket hem, with the top of the design 1/4” below the
top of the pocket. Monograms should be 1/4 to 3/8” tall. If pocket has button in center, shift design to the
right.

Shorts Leg: Halfway between center-front and side seam. The bottom of the design should be 1/4” to
1/2” above the hem stitching at the leg hole.

Short Sleeve Shirt: Center design 1/4” to 1/2” above the hem on the sleeve. Monograms should be
1/4” to 3/8” tall.
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DESIGN CREDITS & THANK YOU

We would like to thank the following companies for their support of Embrilliance software. Many of
the designs shown in our documentation and online help videos have been provided to us to use for
demonstration purposes. Please visit their websites for more information on how to purchase these pro-

fessionally digitized designs.

Adorable Ideas - www.Adorableldeas.com
Lindee G Designs - www.LindeeGDesigns.com
Great Notions - www.GreatNotions.com
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